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N. Parts N. Parts
T [Cover 20 [Electronic board Tocator pins
2 |Base 21 | JP2 current draw limiter jumper (versions with housing
3 [Indicator lights (LED) only): see “Description of jumpers” on page 8
7 [Closing screw (parked position) 22 |Battery connector: versions with housing only
8 [Base mounting holes (4) 23 | ANT5-02 adapter cable
9 [Coverhinge 24 | Adapter cable nut
10 | Antenna cable hole 25 |Integrated antenna: versions with housing only
11 |2700 mAh rechargeable battery (optional): versions 26 [Hole for antenna cable on metal bracket
with housing only 27 |Metal bracket
12 [Wall tamper device 28 |ANT5-02, GSM antenna with 2 m cable and SMA
13 |Hole for wall tamper device fixing connector (optional)
12 |SIM holder 29 |GSM antenna with 2 m cable and MMC connector
15 |PC-LINK connector 30 |Electronic board mounting holes (4)
16 |Programming jumpers: see “Description of jumpers” on
page 8
17 |USB port: versions with housing only
18 | Tamper contact
19 |Terminal boards

A b

Figure 1 - Identification of parts: version with housing.
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Figure 2 - Identification of parts: a) ANT5-02, GSM antenna with 2 m cable and SMA connector (optional); b) version with
housing; c) kit version.
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Hereby, Bentel Security declares that the radio equipment type BGS-220 / B3G-220/ BGS-210 isin compliance with Directive 2014/53/EU.
The full text of the EU declaration of conformity is available at the following internet address: www.bentel security.convdc.
*) The BGS-220, BGS-220K, B3G-220/EU and B3G-220K/EU product models have been certified by IMQ/A to be compliant with standards:
EN 50136-1:2012 and EN 50136 2:2013 for Alarm transmission system performance SP2 (D2, M2, T2, S0, 10) for vocal/SMSalarm messages and SP4 (D3,
M3, T4, 2, 13) for digital messages;
EN 50131-10, Security Grading 2;
TO31.

To ensure conformity with the T031 standard, the Communicator must be connected to the panel with terminals LI and the following events and messages/
codes must be set: INTRUSION ALARM, TAMPER ALARM, MAIN POWER FAILURE, BATTERY FAILURE, HOLD-UP, ARMING, DISARMING,
INHIBITED ZONE AND |SOLATED ZONE.

The communicator is certified IMQ-SECURITY SYSTEMS if powered by the panel and without backup battery.

Installation of these systems must be carried out strictly in accordance with the instructions described in this manual and in compliance with the local laws
and bylawsin force. The above mentioned 220 series is been designed and made to the highest standards of quality and performance. The manufacturer
recommends that the installed system should be completely tested at least once a month. Bentel Security shall not be responsible for damage arising from
improper installation or maintenance by unauthorized personnel. Bentel Security reserves the right to change the technical specifications of this product
without prior notice.

RECYCLING INFORMATION
Bentel Security recommends that customers dispose of their used equipments (panels, detectors, sirens, and other devices) in an environmentally sound
manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. For specific information see
www.bentel security.comvindex.php?o=environmental.

WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT (WEEE) DIRECTIVE

E In the European Union, thislabel indicatesthat this product should NOT be disposed of with household waste. It should be deposited at an appropriate
e facility to enable recovery and recycling. For specific information see www.bentel security.com/index.php?o=environmental.

To program the device, use software BOSSver. 4.0 or later.
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INTRODUCTION

The devices made by BGS-210, BGS-220 and B3G-220 series are cellular communicators that provide a backup PSTN line and
are able to transmit vocal (BGS-220 and B3G-220 only) and SMS alarm messages to the end user, and digital messages to Sur-
Gard System I, 11, 111, 1V and 5 receivers. The following versions are available.

BGS-210: communicator board with 2G module in plastic housing.

BGS-220: communicator board with 2G module in plastic housing.

B3G-220: communicator board with 900/1800 MHz 3G module in plastic housing.

BGS-220K: kit including communicator board with 2G module, antenna with 2 m cable, adapter and metal bracket.
B3G-220K/EU: kit including communicator board with 900/1800 MHz 3G module, antenna with 2 m cable, adapter and metal
bracket.

YVVVYYVY

For special installation requirements, a remote outdoors antenna ANT5-15 with 15 m cable is available.

The information in this manual is common to all versions. The term “communicator” refers to functions shared by all versions.
Information relating to specific models is highlighted with reference to the respective code.

A\ some of the topics found in this manual may not be relevant to your version: refer to “General specifications” on
page 6 to see the features of your version.

This manual provides instructions for programming and using the communicator.
I The communicator may be installed by a qualified technician only and used on in areas with at most Pollution Level 2,

Overvoltage Category Il, indoors in a non-danger zone. These instructions must be used in areas together with the panel's
installation manual. Follow all instructions given in this manual to the letter.

BGS-210/BGS-220 / B3G-220 5



General specifications

Model

BGS-210

BGS-220

Boxed

Mobile phone standard?®

[ <
®

™[ <
@

SI3| BGS-220K
81| B3G-220/EU
8|3 |B3G-220K/EU

Dual Band

Quad Band

Simulates a PSTN line.

Detects the absence of a PSTN line and automatically switches to GSM

Manages and reports incoming and outgoing phone calls

GSM signal strength indicator

Terminals, programmable as open-collector outputs or inputs

T1, T2 and T3 terminals

Protection against overvoltage on the phone line

Integrated antenna

External antenna with magnetic base

SMS dialer

Voice dialer

Contact ID and SIA protocol decoding

Event transmission (audio/digital channel) to Sur-Gard System I, 11, 111, 1V and 5 receivers

Options programmable by PC

Communicator blocked when PINs are at default (EN50136-2)

Programmable text messages (each at most 70 characters long)

D

N

N
N
N

Text messages for each input

Status text messages

oo

oo

oo
oo
oo

Periodic text message

Programmable telephone numbers (16 digit max.)

N

N

N
N
N

Phone numbers for the SMS dialer

Phone numbers for transmitting events to Sur-Gard receivers

Phone numbers for remote output activation

N

N

N
N
N

Remote output activation via call recognition, or SMS

Residual credit monitoring for prepaid SIM cards

Panel Transmission Monitoring (PTM)

Tamper detection

PC-LINK port

Type A USB connector (Host and device)

Programming with USB key

Advanced diagnostics and event log exporting by means USB key

Firmware programming and updates, both local and remote

Alarm event transmission via GSM/GPRS/HSPA

Priority programmable with PSTN/Cellular

Two-way communications with cellphone

Optional backup battery

Current limitator (JP2 jumper)

Alarm panel management and status monitoring

Jamming detection

<[<[z]z[<|<[<]<Zz|z|Z| <] <[ <[ <] <[«| | o] e~z SN[ = <[ <] <[ =] <[ =] <] <= | <[ <[ <[<]<|=

<[ <[=[=<[=<|=<[=<[<]=<[<|=<[<[<[<[<] <[] o] oo v =[ =] S| o] <[ <[ <| <[ <| <[ =] <[ <[ <[ = <|<[<[ <<=

<[<[=<[Z[<|<[<[<[Zz[z|Z[<]Z[<[ <] <[ x| | | | == S| | <[ <[ <] <[<|<[<] =] <<= <[<[<[<]<[=
<[ <[=<[=<[=<|=<[=<[<]=<[<|=<[<]<[<[<] <[] o] o] | == S| | <[ <[ <] <[<| <[ =] <] <<= <|<[<[<]|=[<
<[<[=<[Z[<|<[<[<[Zz[z|Z[<]Z[<[ <] <[ x| | o] | == S| | <[ <[ <] <[<|<[<] =] <<= <[<[<[<|=[<

a. Check that the SIM operator in use supports 2G or 3G standard, depending on the model, in the area where the

communicator is installed.
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Technical specifications

The power for the communicator is supplied by the panel to which it is connected (10.7 V to 27.6 V) or by an external power supply
which also recharges an optional backup battery, if necessary. The sole purpose of the battery is to supply power in case of failure
of the primary power source (8 hours stand-by).

IS" When the communicator is powered by the battery, ONLY communicator events are transmitted.

The primary power and (optional) battery voltages are supervised.
The power supply for communicator models BGS-210, BGS-220 and B3G-220/EU must be SELV, with power limited to 1 A.

BGS-210
Version B??((;gzzozl?/}éu BGS-220
B3G-220/EU
Input Voltage 10.7+276 V===
Standby average current, without battery 90 mA (not including outputs) @ 13.8 V===
Average current consumption per hour 100 mA
Maximum current draw in current limited mode (versions with 230 mA (not including outputs) @ 13.8 V===
housing only)
Maximum current draw 450 mA (not including outputs) @ 13.8 V===
Maximum current on open-collector output 100 mA
Maximum radio-frequency power Class 4 (2 W) @ 850/900 MHz, GSM
Class 1 (1 W) @ 1800/1900 MHz, GSM
Class E2 (0.5 W) @ 850/900 MHz, EDGE
Class E2 (0.4 W) @ 1800/1900 MHz, EDGE
Class 3 (0.25 W) @ 850/900/1900/2100 MHz, WCDMA
Maximum loop resistance of line between the device connected in 1 Kohm
serieson LI
Maximum number of parallel devices connected on LI 1
Environmental class I
Operating temperature -10 + +40°C
Humidity 0+95%
Dimensions (LxHxD) 76x151x20 mm (PCB only) 101x186x41 mm
Weight 66 g 2509
Table 1 - Technical specifications.
) Operating frequency (MHz)
Version
GSM/GPRS/EDGE UMTS/HSPA
BGS-220K, BGS-220, BGS-210 850/900/1800/1900 N/A
B3G-220K/EU, B3G-220/EU 900/1800 900/2100

Table 2 — Operating frequency.
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Interface type between SPT (Supervised Premises Transceiver)
and AS (Alarm System)

Proprietary interface

ATS (Alarm Transmission System) SINGLE PATH

Alarm Transmission System performance SP4 for digital messages | SP2 for vocalltext messages
Average transmission time D3(20s) D2 (60 s)
Maximum transmission time M3 (60 s) M2 (120 s)
Reporting time T4 (180°s) T2(25h)
Substitution security S2 SO
Information security 13 10

Table 3 - EN 50136-1:2012 and EN 50136-2:2013 specifications.
Identification of parts

Numbers given in bold in this manual refer to the main parts of the communicator shown in figure 1 and 2, and the table on page 2.

Description of jumpers

Jumper Position Description
PST ) Reserved (leave open).
UsB X The communicator behaves as a USB Device (factory setting).
=) The communicator behaves as a USB Host.
TMP [©0)] Anti-tamper function enabled (factory setting).
| - Anti-tamper function disabled.

UFC [0 O)] Future use.

No limit to communicator current draw (factory setting).

) A Backup battery required!

JP2
(versions  with !)
housing only)

Communicator current draw limited to 230 mA.

Table 4 — Description of jumpers.
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Description of indicator lights

The communicator is equipped with indicator lights (LED) which report the following information.

I During initialisation, all LEDs light up for less than 1 second. During factory settings restore, LEDs -|||| and il are off while

®)
LEDs A and (A) are on.

LED Colour Name Description
Greenlyellow GSM signal strength Type of network for packet service (see table 6).
||| GSM signal strength (see table 7).
1
|

Type of communication (see table 8).

Red Fault See table 9.
Yellow Line status On: the communicator has switched to the simulated PSTN.
((}é?) Slow flashing: line occupied, voice message transmission.
G Green GSM network status Technical assistance LED.
ACT |Green USB On: Host.
Off: Device.

Slow flashing: error.
Fast flashing: activity.

Table 5 - Indicator LED.

LED Colour Type of network for packet service

Green GPRS or EGPRS
I||| Yellow WCDMA, HSDPA or unknown (3G version only).
1

Table 6 — Type of network for packet service.

.I|I| al GSM signal strength
Off Off No GSM signal.
Off On Low GSM signal strength.
On On High GSM signal strength.

Table 7 - GSM signal strength.

BGS-210/BGS-220 / B3G-220 9



|||| l Type of communication
1

connected, if any.

Slow flashing Slow flashing Initialisation: the LEDs flash until the communicator receives a GSM signal.

Fast flashing off SMS incoming: the LED flashes for a few seconds.

Slow flashing Off Remote session: the LED may flash for a few seconds after the end of the session.
Off Slow flashing Voice call: reports the communicator's voice call, NOT that of the panel to which it is

Table 8 — Type of communication.

Fault LED

This LED is usually off. It flashes to indicate a fault. The communicator monitors faults in the order given in table 9. The most
important fault status is indicated, with the respective number of flashes of the RED LED, as shown in the following table.

Priorities Description Flashes
1 (HIGH) [Firmware problem (incorrect firmware): invalid data in external flash memory. 1
2 Power problems: the power voltage falls below 10 V. 2
3 Battery problems: the battery voltage falls below 3.4 V. 3
4 Factory PIN: the EN50136 option is enabled and the User, Installer or Level 4 PIN is that set in the|4
factory.
5 GSM module fault: the microprocessor is unable to communicate with the GSM module during the |5
initialisation sequence.
6 SIM problem: SIM card PIN check enabled. 6
7 GSM network problem: the radio module is unable to connect to the GSM network. 7
8 GPRS/HSPA network problem: the radio module is unable to connect to the GPRS/HSPA network. 8
9 Future use. 9
10 IP 1 receiver problem: initialisation failure; supervision failure; no ACK. 10
11 (LOW) |IP 2 receiver problem: initialisation failure; supervision failure; no ACK. 1

Table 9 — Fault LED.

10
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Description of terminals

Terminals T1, T2, T3, T4, T5 and T6 can be programmed as described below.

» Open-collector outputs: the outputs can be activated by programmed events (automatic activation), SMS or by call
recognition (remote activation); see “Activating outputs” on page 29 for details. The maximum current draw per output is
100 mA.

» Inputs: the inputs send SMS or voice messages when activated.

Terminals BGS-220 / B3G-220 BGS-210

= Ground: this terminal must be connected to the electrical system ground to protect the device against overvoltage
on the telephone line and to satisfy safety requirements.

LI Internal telephone line: these terminals must be connected to the panel or other communications terminal.

LE External telephone line: these terminals may be connected to the PSTN line.

Tl Factory setting: output, PSTN fault. N/A

T2 Factory setting: output, no cellular network. N/A

T3 Factory setting: input, interconnection present. N/A

T4 Factory setting: output, tamper. Factory setting: output, PSTN fault.

T5 Factory setting: output, GSM fault. Factory setting: output, no cellular network.

T6 Factory setting: output, Jamming. Factory setting: output, tamper.

Vet Earth: power negative and common terminals for the open-collector outputs.

+V Power supplied by panel 10.7 to 27.6 V===: make sure it is protected and current limited (Limited Power Source —
LPS) in conformity with EN 60950-1:2006 standard).
To connect the power, use cable of no more than 3 metres length, and 0.75 mm? cross-section.
For shorter cables, use appropriate cross-sections.

BGS-210/BGS-220 / B3G-220 11



Installation

A\ Connect the power supply and telephone circuits after the communicator is mounted and connected to the building
ground circuit.
Before fitting or removing the SIM card, make sure the communicator is NOT powered up.

I The communicator shall be installed only by a QUALIFIED TECHNICIAN, indoors, in a safe, dry position, away from RF
transmitting equipment.
Position the communicator for good GSM signal coverage.
DO NOT route any cable over the circuit board.
Do not use power cables which are more than 3 m long.

Installing the kit version

The kit version is composed of a board for mounting inside a burglar alarm panel, preferably in a metal enclosure, and an antenna
for connecting to the board with a coaxial cable.

In normal operation, the board, antenna and cable may generate electromagnetic fields and may disturb nearby electronic
equipment which is not immune to such fields.

We therefore recommend that the board be positioned as far away as possible from such equipment and the antenna be mounted
to the enclosure's outer surface or far away from it, using the appropriate bracket.

Route only a minimum amount of coaxial cable into the metal enclosure; gather any excess outside the enclosure.

To install the kit version, proceed as described below and in figure 3.

Open the panel.

Find a place inside the panel to mount the board, including its wiring.

Mount the 4 provided adhesive plastic mounts into holes 30 of the communicator, as shown in figure 3.

Secure the communicator inside the panel.

If the panel has a plastic housing, or if you want to place the antenna within 2 metres of the panel, for better GSM signal
strength, mount bracket 27 in the desired position, otherwise go to step 7.

6. Route the antenna cable through hole 26.

7. Position antenna 29 on the panel's metal housing or on bracket 27, so that the magnetic base adheres to the surface.
8. Route the antenna cable through an opening in the housing.

9. Connect the antenna cable to communicator connector 43.

10. Fit the TMP jumper to disable tamper detection.

11. Continue with the installation as described in paragraph “Power and testing” on page 14.

12. Close up the panel.

a s wn e
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Figure 3 - Installing the kit communicator: A) metal housing; B) communicator board; C) panel motherboard; D) adhesive plastic

mount; E) base of metal housing.
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Installing the version with housing

The version with housing must be mounted to a wall with screws and plugs (not included) as described below and shown in figure 4.

1

ol

&

o o

&

Open the communicator: insert a flathead screwdriver into holes 33 and prise the cover off the base, than slide the cover
upwards to separate it from the base completely.

If you wish to fit the optional battery LIB2A6, read the following steps, otherwise go to step 7.

Remove the electronic board: compress hooks 34 to release the board from the base.

Fit the battery as shown in figure 4.

Make sure the silicon/graphite grommet 12 is in place.

Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.
Connect the battery to connector 22 after having powered the communicator up with terminals +V and /4.

The communicator will NOT operate correctly if it is powered only by the battery when first switched on.

Mark the positions for the 8 base mounting holes and the position of hole 13 for the wall-tamper device.
Drill holes in the marked positions.

Take care not to damage any wires or tubes running inside the wall.

Route the ducted cables in the wall through openings 35 or break out the tabs 32 to route the exposed cables into the
housing.

Mount the base to the wall.

Continue with the installation as described in paragraph “Power and testing” on page 14.

Close the communicator: remove screw 7 from its parked position; slightly tilt the cover; approach the top of the cover to the
base; slide the cover downwards; press the bottom of the cover against the base until it snaps into place; if necessary, secure
the cover to the base with screw 7 in hole 36.

Power and testing

1.

=

6.

Fit the SIM card into SIM holder 14 as shown by the arrows, with its contacts facing downwards.

You must disable the SIM card's PIN before fitting it into the communicator.
We advise disabling call transfer on the SIM card.

Set the jumpers as required by your application (see “Description of jumpers” on page 8).
Make the connections to terminal block 19 as described in paragraph “Connection example” on page 18.

A 4 @
Power up the communicator: all LEDs will light up for 1 second, then LEDs and A" il stay on for a few seconds,

after which LED A will flash 4 times to indicate that the User, Installer and Level 4 Installer PINs are those set at the
factory.

Use the Console to change the PINs, as described in chapter “PC PROGRAMMING” on page 35, and enable the
communicator.

Check the signal strength: make sure that at least LED «Il turns on; if the LED -l||| is on, the signal strength is excellent.

If LEDs +1l and -|||| are off, the signal is NOT strong enough: reposition the communicator or try installing the optional antenna
ANT5-02 (versions with housing only) or ANT5-15, as described elsewhere.

14
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Figure 4 — Installing the communicator with housing.
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I The communicator complies with the EN 50136-2 standard and, for this reason, its access codes have to be set at the first
power up, by means of the Console, in this way the communicator functionality will be enabled.
If you do not need the compliance with the EN 50136-2 and like to start working without the Console, please proceed as
follows.

1. Make sure that the communicator settings are at default (read “Restore Factory Settings” on page 38 to restore the default
settings).

2. Insert the PST jumper.

3. Connect the communicator to the power.

()
4. Wait until the A and A LEDs switch off, then remove the PST jumper.

BGS-210/BGS-220 / B3G-220 15



Installing the antenna ANT5-02

The ANTS5-02 has greater gain than the communicator's integrated antenna in the version with housing, and can be mounted
indoors within 2 meters of the communicator, to improve GSM reception, as described below and shown in figure 5.

IS Position the antenna to optimise GSM reception.

Break the tab closing hole 37.

Remove the electronic board: compress hooks 34 to release the board from the base.

Remove nut 24 and washer 38 from adapter cable 23.

Fit adapter cable connector 39 into hole 37, the secure it with nut 24: washer 38 is not required.

Connect adapter cable connector 40 to connector 43.

Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.

ok wnE

&

Make sure the adapter cable is routed as shown in figure 5.

Secure metal bracket 28 as desired with holes 41.

Route antenna connector 42 through hole 26 in the bracket.

Position antenna 29 on the bracket so that its magnetic base adheres to its surface.
10. Connect antenna connector 42 to adapter cable connector 39.

37 28—
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Figure 5 - Installing the antenna ANT5-02.
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Installing the antenna ANT5-15

The ANTS5-15 has greater gain than the communicator's integrated antenna in the version with housing, and can be mounted
outdoors within 15 m of the communicator, to improve GSM reception.

Refer to the installation instructions included with the ANT5-15 antenna.
Tamper detection

The version with housing of the communicator is equipped with a device which detects when the cover is opened and the
communicator is removed from the wall (tampering).

Tampering is reported by the Tamper event, to which actions can be associated (activate outputs, send voice, SMS or digital
message) with the Console: the factory setting is that terminal T4 on BGS-220 / B3G-220 or terminal T6 on BGS-210 is floating (it
is normally connected to earth) in the event of tamper.

Once you have programmed the function, close the cover and power up the communicator.

After initialisation, open the cover and check that the communicator actually executes the actions programmed for the tamper
detection.

BGS-210/BGS-220 / B3G-220 17



Connection example

A\ Incorrect connections may result in FTC fault or improper operation. Inspect wiring and ensure connections are
correct before applying power. DO NOT route any wiring over circuit boards; maintain at least 1” (24.5 mm)
separation. A minimum 1/4” (6.4 mm) separation must be maintained at all points between Power Limited wiring and

all other Not-Power Limited wiring.

I To ensure conformity with EN 50136-2, the communicator must be connected and programmed as described in paragraph
“Conformity with EN 50136-2:2013" on page 58.

.

T1|T2|T3|T4|T5|T6 | [+V

4| L LE
_ | |
L —=n
o
AD
— v
LIE n L1:/+1
—B |
RJ-11

Figure 6 — Connection example: A) Communicator; B) disconnect the telephone line before servicing the unit; C) example
connection of terminal T1 programmed as open-collector output; D) power 10.7 - 27.6 V===, E) terminals T1, T2, T3,
T4, T5 and T6 can be programmed as open-collector outputs or input lines; F) burglar alarm panel; G) connection to
telephone line (PSTN); H) ground connection (obligatory).
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GENERAL DESCRIPTION

The communicator can communicate with central stations and send both SMS and voice messages; it can also simulate a PSTN
line in case of malfunction (phone line failure) or substitute of one completely in areas with GSM coverage in which PSTN calls are
not available.

IT can report alarms over the GPRS network, for reliable, fast communications with central stations equipped with a Sur-Gard
System I, 11, I11, IV or 5 receiver. The performance of the communicator depends largely on the GSM coverage, and it should not
be installed without having first checked the position of the antenna for best reception (the LED , 1| at least must be on).

The communicator has terminals (T) which can be programmed as follows.

O Output which can be activated/deactivated remotely O Input for:
(reserved manual) or used for reporting the following events:
problem with PSTN line;
problem with GSM network;

Fail To Communicate (FTC);

IP receiver fault;

power failure;

tamper;

panel interconnection fault;

radio disturbance detected (Jamming);
antenna fault;

cellular network fault.

activate voice dialer;

activate SMS dialer;

activate digital dialer;

cancel internal transmissions and delete phone queue;
force communications to GSM.

YV V V V V

YV V VYV V V V VYV VY YVY

I Due to the nature of the GSM network, the communicator may be used solely for its intended purpose and NOT as a modem
for sending faxes or data or for remote assistance services.

BGS-210/BGS-220 / B3G-220 19



Access levels

This paragraph describes how to access the communicators functions, according to EN50136 standard.

If the EN50136 option is enabled (factory default; see “Options’ on page 41), the communicator can handle all four levels of user
access to its functions. The access levels are as follows.

» Level 1: access to function display, indications (LEDs used to report faults, GSM and PSTN status) and messages
(SMS, voice, etc.) available to all users without PIN; this level does not allow any programming.

» Level 2 (normal user): access to communicator status information (e.g. use of the Console to display the status page,
programming options and events buffer). This level requires a PIN. Factory setting: 000000.

» Level 3 (installer): access to configuration functions including addition, removal and replacement of components and other
operations which directly or indirectly affect the communicator's functions (e.g. upload/download programming options with
the Console, display Status page and events buffer). This level requires a PIN. Factory setting: 111111.

I |f the EN50136 option is enabled, the installer must be authorised by the normal user.
» Level 4 (level 4 installer): access to firmware updates and Status page display. This level requires a PIN.
Factory setting: 222222.

I The level 4 installer must be authorised by the installer.
To ensure compliance with EN 50136-2: 2013, the PINs for access to levels 2, 3 and 4 are 6 digit numbers.
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USB connector functions

The communicator has a USB A connector to enable it to work as a device, to connect it to a PC, or as host, to handle a USB key
(see “Description of jumpers” on page 8).

To connect the communicator to a PC, you need a USB cable with A connectors at each end (hub cable).

The USB interface has the following characteristics.
Conformity: USB 2.0.

Full speed data: 12 Mbit/s.

Max. length of cable: 5 m.

Max. current in host mode: 500 mA.

Vout in Host mode: 5 V nominal.

USB key file system: FAT32.

USB device

The USB interface will be an alternative to communications with the RS232 port (PC-Link). It will have the same functions as the
RS232 and will be used with the Console to:

» update the firmware (level 4 installer only);

» upload/download communicator options and audio files (installer only; the normal user can only upload);

>

>

YVVVVYYVY

upload the communicator's events buffer (installer and normal user only);
check the communicator's status in real time (all users).

USB Host

Allows you to use a USB key for the following operations:

» firmware updates;

» upload/download settings and audio files;

> export the events buffer;

> export the communicator's debug buffer (technical service only).

These functions are available only if the EN50136 option is disabled.
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Power Monitor

The device can be powered in the following ways:

1. by the burglar alarm panel, equipped with a backup battery, in which case the communicator must operate at voltages in the
range 10.7to 27.6 V.

2. byan external 12 V power supply, in which case the power supply must recharge the communicator's optional backup battery
(8 hours of operation following primary power outage).

In both cases, the battery ensures that the communicator is still operational in case of power failure.

The power and battery voltages are supervised so that the communicator can report the following events:
»  Power fault/restore event.
»  Power fault/restore message (voice / SMS / message to the IP receivers).

Since the device can operate with or without an external backup battery (without input current limitation), the following two scenarios
correspond to a power failure.

Power voltage check

The power voltage will be supervised to detect problems. The voltage is checked every 100 ms. The following conditions apply to
the device without external backup battery:

»  Power problem event: when the voltage drops below 10 V (the PSTN interface is turned off).

»  Power problem restore: when the voltage rises above 12 V.

»  Start Energy Save mode: when the voltage drops below 9 V (the USB interface and the radio module are turned off).
»  Quit Energy Save mode: when the voltage rises above 10.7 V.

IS" When the communicator is in Energy Save mode, the current draw does not exceed 175 mA. The maximum current
consumption, in Energy Save mode with battery connected and no action in progress is around 70 mA and is less than 150 mA
during voice calls.

Battery voltage check

The battery voltage will be supervised to check for any faults and that the battery itself is present. The voltage is checked every
100 ms. The value is processed (mean of values) to eliminate peaks. The following conditions apply to the device with external
backup battery:

Battery problem event: when the battery voltage drops below 3.4 V.
Battery problem restore: when the battery voltage rises above 3.7 V.
Start Energy Save mode: when the battery voltage drops below 3.2 V.
Quit Energy Save mode: when the battery voltage rises above 3.4 V.
Battery disconnected event: when the battery voltage drops below 2.0 V.
Battery disconnected restore: when the battery voltage rises above 2.0 V.
Battery overload event: when the battery voltage rises above 4.4 V.
Battery overcharge restore: when the battery voltage drops below 4.3 V.

VVVVVYYYVYY

=" When the communicator is powered ONLY by the battery, you can NOT use the USB port.
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Internal events

Along with the external events (panel events decoded with the Contact ID / SIA protocols on the simulated PSTN line),
the communicator also recognises the following events.

Event Description
Input 1 Event This occurs when terminal T1 is programmed as an input and the conditions for its
activation obtain (see “Inputs/Outputs’ on page 44).
Input 2 Event Like Input 1 Event but for terminal T2.
Input 3 Event Like Input 1 Event but for terminal T3.
Input 4 Event Like Input 1 Event but for terminal T4.
Input 5 Event Like Input 1 Event but for terminal T5.
Input 6 Event Like Input 1 Event but for terminal T6.

Input 1 Restore

This occurs when terminal T1 is programmed as an input, and returns to standby status
(see “Inputs/Outputs’ on page 44).

Input 2 Restore

Like Input 1 Restore but for terminal T2.

Input 3 Restore

Like Input 1 Restore but for terminal T3.

Input 4 Restore

Like Input 1 Restorebut for terminal T4.

Input 5 Restore

Like Input 1 Restore but for terminal T5.

Input 6 Restore

Like Input 1 Restore but for terminal T6.

Mains Fault

Happens when the power voltage (terminal +V) drops below 10 V.

Mains Fault Restore

Happens when the power voltage (terminal +V) rises above 12 V.

Battery Fault

Happens when the battery voltage falls below 3.4 V.

Battery Restore

Happens when the battery voltage rises above 3.7 V.

Panel Interconnection Fault

Happens when the terminal programmed as the Panel | nter connection Present input
is activated (see “Inputs/Outputs’ on page 44).

Panel Interconnection Restore

Happens when the terminal programmed as the Panel | nter connection Present input
is deactivated (see “Inputs/Outputs’ on page 44).

Cellular Receiver 1 Fault

Happens when the communicator is NOT able to communicate with receiver 1:
initialisation failure, supervision failure or receiver does not respond (see “I P Receivers’
on page 52).

Cellular Receiver 2 Fault

Like Cellular Receiver 1 Fault but for receiver 2.

Cellular Receiver 1 Restore

Happens when the communicator is able to communicate with receiver 1: initialisation
successful, supervision successful or receiver responds (see “IP Receivers' on
page 52).

Cellular Receiver 2 Restore

Like Cellular Receiver 1 Restorebut for receiver 2.

PSTN Fault

Happens when the voltage on terminals LE is less than 2.5V for the set LE Failure
Timeout (sec) (see “Timeouts’ on page 54).

PSTN Fault Restore

Happens when the voltage on terminals LE is more than 2.5V for the set LE Restore
Timeout (sec) (see “Timeouts’ on page 54).

Cellular Network Fault

The communicator can NOT connect to the cellular data network.

Cellular Network Restore

The communicator can connect to the cellular data network.

Tamper Event

Happens when tamper detection is enabled (see “Description of jumpers” on page 8) and
the communicator is opened or removed from the wall (versions with housing only).

Table 10 - Description of events handled by communicator.
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Event Description
Tamper Restore Happens when tamper detection is enabled (see "Description of jumpers™ on page 8) and
the communicator is closed again or mounted to the wall (versions with housing only).
FTC Fault Happens when an action fails (voice call, SMS, digital message).
FTC Restore Happens when the last action in the queue terminates successfully.
Periodic Call/SM S Happens when programmed (see “SM S/Voice Calls' on page 46).

Table 10 - Description of events handled by communicator.

The installer can choose which protocol to use: Contact ID or SIA.
I The selected protocol is also applied to events generated by the panel and sent to the phone numbers with the | P Receiver
on GSM Path option enabled (see table on page 39).

To each event associated with the communicator's inputs, a specific Customer code can be assigned, while status events can be
assigned a unique user code.

The communicator handles a queue of 32 internal events. When the queue is full, further events are ignored.
The priority between internal and external events can be programmed by the installer (see “Priorities’ on page 42).

For internal events, the times and manners in which they are sent are handled by the communicators: after a message is sent, the
unit waits for at most 1.25 seconds for the receiver to acknowledge reception (ACK). The unit will try to send a message up to
4 times. Events are transmitted to the digital receiver (see “Communicator” on page 46).
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Operating Principles

The communicator can choose its primary channel (the factory setting is PSTN). It supplies the line and ringtone voltage for
incoming calls and decodes dial tones (DTMF). The simulated PSTN line provides a backup for the burglar alarm panel or other
terminal should the main PSTN line fail. Calls CANNOT be switched between PSTN and GSM, or vice-versa, while they are in
progress. Operating priority (as programmed) determines how the communicator handles SMS and voice messages, and calls with
devices connected to terminals L1 (for example, a burglar alarm panel).

I The communicator is NOT able to decode pulse dialing.
To prevent undesired use of the simulated line via GSM, the device generates a double beep during voice calls. It does so
after 5 minutes and every 30 seconds thereafter.

PSTN channel

If the voltage on the PSTN terminals (L E) falls below 2.5 V DC (+ 20%) for 10 to 3600 seconds (programmable value), the devices
connected to terminals L1 are switched to the GSM network. When PSTN service is restored, the communicator switches back
to the PSTN line, again after a programmable delay.

I |t is possible to force communications to the GSM/cellular data network, even when PSTN is present, by entering a
programmable prefix (factory setting “9999") ahead of the phone number dialled by the panel (for further details, see Dialing
Prefix in “PSTN/PTM” on page 54).

If the device is on the simulated GSM line for any reason, the prefix is deleted from the number (if present).

Number dialled by Phone line Number with | P Receiver Effect

panel on GSM Path enabled
0123456789 PSTN None PSTN voice call to 0123456789.
99990123456789 |PSTN 0123456789 Contact ID call on cellular data network.
99990123456789 |PSTN None Voice or Contact ID call on GSM to 0123456789.
99990123456789 | Simulated GSM 0123456789 Contact ID call on cellular data network.
99990123456789 | Simulated GSM None Voice or Contact ID call on GSM to 0123456789.

Example: the communicator makes independent calls only on the GSM/cellular data network, and not on the PSTN line.
All communications made on the external PSTN line (terminals LE) come from the line connected to terminals LI, and are not
modified. It follows that the PSTN line connected to LE is not considered a communications channel pursuant to EN 50136.

GSM channel

This provides the devices connected to the LI terminals with a simulated line if GSM reception is detected. If there is no GSM
coverage, it switches to PSTN.
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Contact ID/SIA transmission sequence on cellular data network

If phone numbers (prefixes on the PTM page) have been entered on the Console, the communicator switches the calls to these

numbers to the cellular data network.

> When an event occurs, the burglar alarm panel engages the phone line.

» The dial tone is simulated.

» The burglar alarm panel dials the number of the central station. Make sure that the panel inserts at least a 1 second pause or

checks for the dial tone before dialling the number.

The communicator sends the handshake tone required for Contact ID or SIA.

After it receives the handshake, the panel transmits the alarm events.

The communicator decodes and transforms the message into a data packet and sends it to the central station receiver via

the cellular data network.

» The receiver recognises the event and sends an acknowledgement (kiss-off) to the communicator, which forwards the kiss-
off signal to the panel.

»  After the communicator has generated the kiss-off signal, if no other events are to be sent, the panel hangs up, or sends the
next event.

SMS dialer

In SMS dialer mode, one or more previously programmed numbers (up to 8 of the numbers in the Phonebook) are sent the SMS
(max. length 70 characters), associated with the events listed in table 10 on page 23.

Y V V

IS" An SMS is sent when one of the above listed events occurs, for which an SMS has been programmed and at least one number
has been assigned.

Voice dialer

In voice dialer mode, one or more previously programmed numbers (up to 8 of the numbers in the Phonebook) are sent up to
3 pre-recorded voice messages. Up to 150 voice messages can be recorded, of up to 6 seconds each. The messages can be
associated with the events listed in table 10 on page 23.

A voice call is made when an event occurs for which a voice message has been programmed and which has at least one phone
number. In this case, the communicator executes the procedure indicated below.

1. The communicator dials the number and makes the call via GSM.

2. The communicator checks that the number is not engaged and that there are no problems with the GSM network before
proceeding, otherwise it terminates the call and tries step 1 again, for the programmed number of times (Call attemptsin
par. “SMS/Voice Calls’ on page 46), after which it concludes the call cycle. If the event has been programmed to call
multiple numbers, they are called in sequence. This prevents the system calling an occupied number several times in a few
seconds.

3. The communicator waits up to 60 seconds for the called number to answer. If the number answers, it goes to step 4,
otherwise it hangs up and tries step 1 again, for the programmed number of times (Call Attemptsin par. “SMS/Voice
Calls’ on page 46), after which it concludes the call cycle.

4. The communicator plays the message for the channel in alarm: the call is terminated only after the message has been received
or the called user presses ] on his phone, if the Call Confirmation option is enabled (see “SMS/Voice Calls’ on
page 46).

If multiple events requiring different messages to be sent to the same number have occurred, the messages are played in
sequence, each for the programmed number of Repetitions (see “SMS/Voice Calls’ on page 46), during a single call, to avoid
calling the same number multiple times.

If, at the end of the call cycle, the input which activated the communicator is still in alarm, the above procedure is not repeated.
The input which tripped the call cycle must first be deactivated and then activated anew before a new cycle of calls is tripped.
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Priority handling

The communicator can:

VVVVVYYYVY

The priorities of all the above actions can be set on the Console (see “Priorities’ on page 42).

forward panel voice messages via GSM;

forward panel Contact ID messages on the GSM voice channel;

send its own voice messages;

send its own SMS;

send its own digital messages (Contact ID/SIA) on the cellular data network;
handle incoming SMS;

send data packets for supervising communications with IP receivers.

The following table shows the factory default priorities.

N. Action Priorities Programmable
on the Console
1 Forward panefl voice/Contact ID messages on the GSM voice channel. 0 (HIGH) Yes
2 Send communicator digital messages (Contact ID/SIA) on the cellular data network. |1 Yes
3 Send communicator voice messages/SMS. 2 Yes
4 Handle incoming SMS. 3 No
5 Supervision over the cellular data network. 4 (LOW) No

Table 11 — action priorities - factory settings.

Factory operation
» Ifthe device is transmitting an event and another event of higher priority occurs, the communicator interrupts transmission of

YV V

the lower priority event and queues it.

After the higher priority event has been transmitted, the communicator tries again to transmit the interrupted (queued) event.
If several events of the same priority occur together, they are queued and transmitted in sequence.
The communicator's voice messages have lower priority than panel events: if a panel event occurs while the communicator is
transmitting a voice message, the communicator hangs up and the panel takes over the line (pick up detected); after the
event has been transmitted (hang up detected) the communicator tries again to transmit the interrupted (queued) message.

If the communicator's voice messages have higher priority and a panel event occurs while a communicator voice message is

being sent, the communicator must provide the engaged signal to the panel and continue transmitting its messages.

Communicator SMS have lower priority than panel messages and the communicator's voice messages, but an SMS cannot

be interrupted while it is being sent.

The lowest priority is given to data packet transmission for supervision of communications with the IP receivers.
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Pay as you go balance check

If programmed on the Console (see “Pay As Y ou Go Balance' on page 42), you can check your balance on the prepaid SIM

card. Once enabled, the system can check the pay as you go balance in three ways:

1. Onthe Console (Status page, only via PC-Link or USB connection).

2. By SMS to request a response to the sender's number. The command must include the normal user PIN.

3. An SMS containing the service provider's pay as you go balance information is periodically sent to the first number in the
Phonebook. For all service providers which support pay as you go balance check with network commands, the query string
can entered with the Console.

I At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.

Panel Transmission Monitoring (PTM)

Constantly controlling communications with the panel (PTM function) enables the communicator to send calls via GSM if
communications between the panel and the central station via the PSTN line fail. If programmed (on the Console, PSTN/PTM
page), this function is only enabled when the PSTN line is connected to terminals LE and is present.

I Pulse dialing detection is not supported.
When the PTM function activates, the PSTN fault event occurs.

The communicator checks the LE line and, once it has detected that the line is occupied by the panel, executes the following

procedure:

» it decodes the dialled number (DTMF);

» if the decoded number has PTM enabled, the communicator check for the Kiss-Off signal (it acknowledges the reception of
the event sent from the panel to the central station).

The panel must make the call immediately: the time between picking up and making the call, programmed on the panel, must be
at least 2 seconds.

If the PTM All Number s option is enabled (see “PSTN/PTM” on page 54) the communicator will check for the kiss-off for all
calls.
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Activating outputs

The communicator has terminals (T1, T2, T3, T4, T5 and T6) which can be programmed as Inputs or Open-Collector Outputs. The
Open Collector outputs can be activated automatically (when certain programmed events occur) or remotely, by SMS or caller
recognition using a preprogrammed number.

Automatic output activation/deactivation
The Open Collector outputs of the communicator may be activated automatically by the following events.

Panel interconnection fault: activated when the connection with the panel is not present.

Jamming detect: the output is activated by detection of jamming (terminal T 6, factory setting).

Antenna fault: the output is activated when the antenna is missing or the antenna has limited function (ANT5-02 only).

Tamper: the output is activated when tamper is detected (terminal T4 on BGS-220 / B3G-220 or T6 on BGS-210, factory

setting).

PSTN fault: the output is activated when the PSTN malfunctions (terminal T1 on BGS-220 / B3G-220 or T4 on BGS-210,

factory setting).

» GSM fault: the output is activated when the GSM fails, a SIM problem occurs, or there is no signal (terminal T5,
factory setting).

» No cellular network: the output is activated when the data connection fails (terminal T2 on BGS-220 / B3G-220 or T5 on

BGS-210, factory setting).

IP receiver fault: the output is activated when communications with the IP receivers fail.

Power fault: the output is activated when there is a power fault or failure.

FTC fault: the output is activated when an event send fails.

Y VYV
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I An automatically activated OC output returns to standby when all the causes that tripped it are resolved, except for FTC fault,
in which case it returns to standby after a set delay (ON time).

Remote output activation/deactivation

IS" The GSM connection must be present for the outputs to be remotely activated/deactivated.
To enable this function, the output must be configured as a Reserved Output.
When terminals T1, T2, T3, T4, T5and T6 are programmed as outputs, they may be controlled remotely via SMS and Caller ID.
The SMS is never saved to the device, but is deleted as soon as the command has been executed.
The number used to activate the outputs using Caller ID must NOT be concealed (it must NOT be a private number).
To avoid calls being forwarded to devices connected to terminals L1, we recommend the communicator is programmed with
the Black List Enabled enabled (Options > Dial Options) and White list disabled (Phonebook) for the numbers you
wish to use for this function, calls will be rejected in this way.

The Open-Collector outputs can be programmed as Bistable or M onostable:

» Bistableoutputs are activated/deactivated with two separate commands;

» Monostable outputs stay active for the programmed M onostable Time On, after which they return to standby, or until
they are deactivated by SMS.

Each output can be programmed to return a confirm signal:
» apreviously programmed SMS, if the output was activated/deactivated via SMS;
> aconfirm ringtone, if Caller ID was used.

I |f Caller ID is used, the call hangs up automatically 12 seconds after the output is activated.
For further details on the Control Sring and User Code options used in the following paragraphs, refer to paragraphs
“Inputs/Outputs’ on page 44 and “Options’ on page 41.
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Bistable outputs
Open Collector outputs configured to be bistable may be activated in two ways:

1. By sending an SMS consisting of the pound (#), the User Code, the Control String (Control Sring can not have initial
blank spaces) and the characters =ON*, as follows:

#User Code*Control String=ON* (example: #123456*HOMELIGHT=0ON*)
2. Using Caller ID: in this case, the output is activated without charge, since once the device has recognised the caller, it
activates the output without accepting the call.
I An OC output configured as bistable can ONLY be deactivated by an SMS composed of the pound (#), the User Code, the
Control String and the characters =OF F* using the following syntax:

#User Code*Control String=OF F* (example: #123456*HOMELIGHT=0OF F*)

I The 6 digit user code is factory set to 000000; to replace it, see “Changing the user code” on page 32.
Monostable outputs

OC outputs configured as monostable can be activated in 2 ways: by SMS and using Caller ID.

SMS

Send an SMS composed of the pound (#), the User Code, the Control Sring (Control String can not have initial blank spaces)
and by the characters =ON*, =ON* TonU* or =OFF* using the following syntax:

#User Code*Control String=ON*
#User Code*Control Sring=ON* TonU*
#User Code*Control String=OF F*

The =ON*TonU* parameter sets the ON time from 1 to 86400 seconds, with a resolution of 1 second. The ON Time can be set
by means of the Communicator's Console software. Ton is the required value and U is the unit in hours (H), minutes (M) and
seconds (S), as shown in the following example:

SMS Example Effect
#123456*HOMELIGHT=ON* Bistable activation.

#123456*HOMELIGHT=ON** Activated as programmed.

#123456*HOMELIGHT=ON*3600S* Active for 3600 seconds.

#123456*HOMELIGHT=ON*50M * Active for 50 minutes.

#123456*HOMELIGHT=ON* 3600* Activated as programmed, the invalid ON time parameter is ignored.
#123456*HOMELIGHT=ON*000S* Activated as programmed, the invalid ON time parameter is ignored.
#123456*HOMELIGHT=0OFF* Deactivated.

IS To activate the output with an SMS using the programmed settings, remove the parameter TonU and leave the characters **.
(Example: #9876*HOMELIGHT=0ON**).
If the monostable output is programmed incorrectly, the output will be activated for the Monostable Time On set in the
Console.
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Caller ID

The output is activated free of charge, since after it has recognised the caller, the device activates the output without answering
the call.

I Monostable outputs return to standby after the programmed Monostable Time On.
The Monostable Time On can be set from 1 second to 86400 seconds, with a 1 second resolution.
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SMS Programming

In addition to the processes described in the paragraph “Remote output activation/deactivation” on page 29, it is also possible to
carry out other remote procedures through the transmission of various SMS messages.

Changing the user code

The default user code is 000000; to change it, send an SMS message consisting of the characters #CUC followed by the current
user code and the new user code between * characters, in accordance with the following formula:

#CUC*User code*New user code*

The device will send an SMS to confirm that the user code has changed.

I The new user code must be 6 digits long (0-9).

Enabling/disabling remote programming

Remote programming allows you to operate the Console over a network. To set the communicator's parameters remotely, you must
enable remote programming, either with the Console (see “Network Settings’ on page 43), or with an SMS composed of the
characters #ERA followed by the User Code and ON enclosed in * as follows:

#ERA*User code*ON*
To disable remote programming, send the following SMS:

#ERA*User code*OF F*
The device will confirm with an SMS.
Changing the installer code

The 6-digit installer code is used to access the remote programming interface (see “Installer Authentication” on page 41). The
default installer code is 111111; to change it, send an SMS message consisting of the characters #CI C followed by the current
Installer code and the new Installer code between * characters, in accordance with the following formula:

#CI C*Installer code*New installer code*

IS The new installer code must be 6 digits long (0-9).
If the EN50136 option is enabled, the installer must be authorised by the normal user for the installer code change to
take effect.

The device will send an SMS to confirm that the installer code has changed.
Changing the level 4 installer code

The default level 4 installer code is 222222; to change it, send an SMS composed of the characters #CM C followed by the current
Level 4 Installer code and the new Level 4 Installer code enclosed between *, as follows:

#CMC*Level 4 installer code*New level 4 installer code*
I The new level 4 installer code must be 6 digits long (0-9).
For the Level 4 installer code change to take effect, the Level 4 installer must be authorised by the installer.

The device will send an SMS to confirm that the level 4 installer code has changed.
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Pay as you go balance check

To check your pay as you go balance with an SMS, you can either use the Console (see “Pay As'Y ou Go Balance’ on page 42)
or send an SMS composed of the characters #CCC followed by * and the user code, as follows:

#CCC*User code*
or #1CCC followed by * and the installer code, as follows:
#l CCC*Installer code*
IS You will receive an SMS with the pay as you go balance.

At the GSM service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.
If the EN50136 option is enabled, the installer must be authorised by the normal user for the command to work.

Checking the expiration date

To find out the expiration date of the SIM card with an SMS, send an SMS composed of the characters #EDC followed by * and
user code, as follows:

#EDC*User code*
You will receive an SMS with the expiration date.
Updating the expiration date

To update the SIM card's expiration date with an SMS, send an SMS composed of the characters #EDU followed by *, the user
code and the new date, as follows:

#EDU*User code*new date*
The date must have the format DD/MM/YYYY.
I |f an expiration date has NEVER been set on the Console, the expiration time is set to 10:00 AM.

If a date and time of expiration have been set with the Console and you then change the expiration date with an SMS using
the command #EDU, the expiration time is unchanged.

Checking the serial number

This command is used to check the communicator's serial number with an SMS composed of the characters #RI D followed by *
and the user code, as follows:

#RI D*User code*
or #1R1 D followed by * and the installer code, as follows:
#| RI D*Installer code*
The device will respond with the RID: 01234567.
Enabling the installer
To enable the installer to work with the device, the user must send a SMS composed of #ENI followed by the User code as follows:
#ENI*User code*

The device will confirm with an SMS.

I The installer must be enabled only if the EN 50136 option is enabled; if not, the installer is always enabled.
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Disabling the installer

To disable the installer from working with the device, the user must send a SMS composed of #DSI followed by the User code as
follows:

#DSI*User code*
The device will confirm with an SMS.
I The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.
Enabling the level 4 installer

To enable the level 4 installer to work with the device, the installer must send a SMS composed of #ENM followed by the I nstaller
code as follows:

#ENM*Installer code*
The device will confirm with an SMS.
The level 4 installer is automatically disabled after 12 hours.

Start a remote session

To start a remote communicator session, send an SMS composed of #SRS followed by the Console IP and the Console port
between *, as follows:

#SRS*Console IP* Console port*

where:

» the Console IP if the public IP of the PC in the format “AAA.BBB.CCC.DDD" (e.g. 37.207.123.181) or host/domain name
format (Fully Qualified Domain Name, e.g. “my_name.dyndns.org”);

» the Console port is the IP port in the format “NNNNN" (a 5 digit number in the range 1 to 65535).

IS You must set the router to which the Console's PC is connected to enable port forwarding from the Console port to TCP port
51004 (the port used locally by the Console, this is NOT editable): ask your network administrator or refer to the router's
instructions.

The APN specified in the Console Network Settings page will be used, or the one programmed for Receiver 1 (IP Receivers
page).

If no APN has been programmed (neither in the Network Settings page nor in the | P Receiver s page), the SMS must specify
the connection as follows:

#SRS*Console IP*Console port*APN access point name*

In some cases, if the APN USERNAME (max 32 characters) and PASSWORD (max 32 characters) are set, the above string is
sufficient to initiate a session, otherwise the string must be modified as follows:

#SRS*Console IP*Console port*APN access point name*User name*Password*
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PC PROGRAMMING

IS For the communicator to work properly, you must use a 32 kB or better SIM card.

To program the system with a PC, you need a PC-Link cable (not included), connected between connector 15 of the communicator
and a PC COM port, and the Console (Figure 7). Take care to insert the PC-Link cable properly. Once the connection has been
made, select the COM with Tools> M odem Manager Configuration. If you have a problem with communications, check the
cable and the serial port settings.

Figure 7 — PC-Link cable connection: A) RS-232 female connector, solder side B) insert the PC-Link cable properly.

Alternatively, connect the communicator to a PC with a USB A-A cable (hub cable), see “USB connector functions” on page 21.
IS Be sure that the PST jumper is NOT present otherwise communicator programming and status view are NOT possible.

I Toinstall and run the Console, you must have admin rights on the PC; we also recommend that you check the firewall settings
if you encounter problems during the installation procedure.
The Console can be downloaded from www.bentelsecurity.com.

1. Install the Console.

2. Runthe Console.

3. Select the user name and enter the password to enter the session: the factory setting uses the username admin and the
password is 1234.

4. Open the File menu and click on New Account to create a new account or open an account listed in the Start Page:
double click on the account to open it.

IS To change the Console's language, click on Tools> Edit Current User; select the language in the next page.
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Description of the menus

Filemenu

New Account: Creates a new account and assigns the factory settings to all parameters.
Account Group Maintenance: groups several accounts into a group.

Recent Files: selects an existing account.

Exit: Exits the program. You will be prompted to save any changes made to the current installation.
View menu

Sart Page: equivalent to clicking on the Start Page tab.

Toolbar: opens the Account Group M aintenance field.

Operators Online: list of connected users.

Open Accounts: list of saved accounts.

VVVVOVYYVYYQ

Communication Jobs: lists the communication sessions; you can also click on & .

Recent Activity: list of recent activity.

Toolsmenu

Language M anager: modifies, imports/exports, creates new languages.

Bentel Operating Security Software 4.0 operator Maintenance: in this window, the administrator can modify his
password and set the password for a user (with possible functional restrictions—Edit Operator Roles) for the Console.
Modem Manager Configuration: sets the type of connection: PCLINK or COM port.

Edit Current Operator: see previous page for changing the Console language.

Backup/Restore Database: sets the database management options.

Recycle Bin: select the account and delete it.

Window menu

Close All Tabs: closes all open account tabs.

Sart Page: equivalent to clicking on the Start Page tab.

Help menu

About BOSS: displays the Console version.

End User License Agreement: displays the text of the license agreement.

Updates Check For Updates—Show | nstalled Updates—M anually Install Update.

Send Feedback: send a comment to the manufacturer

Description of icons

vvgvy

VVVVOVVOVYVYYVYY

Global Upload: displays the communicator's settings on the PC.

" Global Download: once a new account has been programmed (or an existing account has been modified), sends the new
settings to the communicator.

[ﬂ Save: if you change the settings for the existing account, click on Save to save the new configuration.
AN Connect Only.
@ Communicate Tags.
Df Upload Event L og.
m Clear all tags.
/\5 Disconnect When Complete.
‘ Programming/Audio Import/Export.
i Select User: displays only information relating to the Normal User, Installer or Level4 Installer.

Q Option Name Sear ch: enter the name of the option to the left of the icon.
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Icons present on all programming pages.

& Clear all tagsfor thisgroup.

"H Export.
3 Restore all optionsto default.
A= Restoreall optionsto original.

9 Tag all for upload: select all page options for upload.

O Tag all for download: select all page options for download.
Trl(ifollowing pages are available in the programming section.
= phonebook: the phonebook page.

ﬂ‘n Options: options page.

“* Firmware Update: the icon only displays when the L evel 4 I nstaller is enabled and is updating the firmware in this page
(see icon Select User).

“* Network Settings: connection settings page
[ Inputs/Outputs: programs the communicator's inputs and outputs.
= Communicator: communicator programming page.
= | P Receiver s programs all IP receiver options.
Voice M essages. voice message management page.
% PSTN/PTM: configures the PTM function.
L Event L og: configures the event buffer.
e Satus communicator monitoring page.
If you wish to configure a new account, go to File > New Account.

To display the list of accounts in the database, select View > Sart Page or click on Start Page. In this section you can delete
or recall the configuration for a given account as follows:

1. Right click on the account name.

2. Select Open to load the data from the database or Delete to delete the account and all its settings from the database.

To load an account, you can simply double-click on the account name.
You can also order the list alphabetically or by code by clicking on the header of the column in question.

All settings are available on the following pages. This chapter describes in detail the application's pages.

I Depending on your level of access (Normal User, Installer or Level 4 Installer) the settings pages will display differently.
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Programming/Audio I mport/Export
Button opens a window with the following functions.

Export Programming: click on this button to export the current settings from the Console to a USB key.

(%]

P
s

. Import Programming: click on this button to import a communicator's settings from a USB key to the Console; the
“{5 settings may be those previously exported from a Console running on another PC, or from a communicator.

1) Export Audio: click on this button to export the voice messages from the Console to a USB key.

ge=s 'Mmport Audio: click on this button to import the voice messages from a USB key to the Console; the messages may
(@ be those previously exported from a Console running on another PC, or from a communicator.

Restore Factory Settings
To restore the communicator's factory settings, proceed as follows.

Shut off power to the communicator.

Short pins 1 and 4 of the PC LINK 15 connector and restore power.

All LEDs will turn on, and after a few seconds the green ones will turn off to indicate that the factory restore is in progress.
You can now remove the short connection between pins 1 and 4 of connector 15.

Hwn e

5. Once the procedure terminates, the LEDs A will flash to indicate that the PINs have been restored to their values; the
other LEDs remain off.

I Recorded voice messages are NOT deleted by the factory restore procedure. Voice messages can be deleted in the Console's
Voice Messages page.
The factory restore procedure may NOT be executed if the communicator is ONLY powered by its backup battery; you must
reconnect its primary power supply.
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Phonebook

You can save up to 32 phone numbers in this page.

I |fthe periodic pay as you go balance function has been programmed for the communicator's SIM card (see the Optionspage)

the answering SMS is sent to phone number #1.

O Labe: enter an alphanumeric string of at most 16 characters.

O Phone Number: enter a phone number with the international dialing prefix in the format “+xxx" (e.g.: +39 for Italy). Up to
16 digits at most are allowed (the “+" counts as a character).

I The numbers in the phonebook are used to activate outputs, for the SMS communicator, the voice communicator, the
IP receiver and for PTM (Panel Transmission Monitoring).

O WhitelList: if Black List Enabled option is enabled (see Options > Dialing Options) the communicator will forward
to devices connected to terminals L1 (e.g. a burglar alarm panel or a telephone set) the calls coming from numbers with this
option enabled and will block calls coming from all other numbers, as explained by the following table.

Black List Enabled White List Operating Mode

Disabled Disabled Incoming calls from any number are forwarded to LT.

Disabled Enabled Incoming calls from any number are forwarded to L 1.

Enabled Disabled Incoming calls from any number are blocked.

Enabled Enabled ONLY incoming calls from numbers with White List option enabled are
forwarded to L I; incoming calls from any other number blocked.

I This option affects ONLY calls over GSM; incoming calls to communicator's terminals LE are ALWAYS forwarded to terminals
LI.

I Numbers having the White List option enabled must have Caller ID enabled otherwise the communicator blocks the call.

O Activate Output: click on [+] to select the outputs (1 =T1,2=T2,3=T3,4=T4,5=T5 and 6 = T6) to activate when the
communicator receives a call from the number in question. This function is independent of the White List and Black List
Enabled settings in Options > Dialing Options. To activate the output, Caller ID must be enabled, for the number in
question.

I To activate the output, set terminal T1, T2, T3, T4, T5 or T6 as Output and enable Reserved Output option (see I nputs/
Outputs page).

O Output Activation Confirmation: check this box to receive a ring tone to confirm activation of the output.

I The ringtone will sound 1 minute after the output has been activated.

If the communicator is busy with another operation (for example, the GSM channel is busy with voice communications),
the ringtone will not be sent.

O PTM: enable this options to activate the “PTM" function for the number in question. Use this option to monitor the panel's
calls to a PSTN receiver's number (central station). Factory setting: disabled.

O CID/SIA Event Conversion: enables sending of messages by voice or SMS, by decoding the panel's CID/SIA packets
(see table 12 on page 40).

0 Virtual Receiver on GSM Path: if CID/SIA Event Conversion is enabled and the option | P Receiver on GSM
Path is disabled, this function forces the communicator to simulate a receiver (the communicator sends a handshake and
kissoff to the panel).

O IP Receiver on GSM Path: enables decoding of events transmitted by the panel to the phone number and the

transmission of events on the cellular network to IP receivers (central station).
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PSTN/
Gsmt

Communication
protocol?

CID/SIA
Event
Conversion

Virtual
Receiver on
GSM Path

|PReceiver
on GSM
Path

Effects

PSTN

No effect

Disabled

No effect

No effect

The panel's voice and digital messages (SIA and
CID) are forwarded to PSTN.

PSTN

SIA/Contact ID

Enabled

No effect

No effect

The panel's voice and digital messages are
forwarded to PSTN.

The digital messages are converted to voice or SMS
messages (as set in the Communicator > CID/

SIA Converter page) and forwarded on GSM3.

GSM

No effect

Disabled

Disabled

Disabled

The panel's voice messages are forwarded to
GSM,

GSM

Contact ID

Enabled

Disabled

Disabled

The panel's voice and digital messages (CID) are
forwarded to GSM¥,

The digital messages (CID) are converted to voice
or SMS messages (as set in the Communicator >
CID/SIA Converter page) and forwarded
on GSM3,

GSM

SIA/Contact ID

Enabled

Enabled

Disabled

The digital messages (CID or SIA) are converted to
voice or SMS messages (as set in the
Communicator > CID/SIA Converter page)
and forwarded on GSM?,

The communicator simulates a receiver by supplying
the handshake and kissoff messages.

GSM

SIA/Contact ID

Disabled

Disabled

Enabled

The digital messages (CID/SIA) are decoded and
forwarded on the cellular data network to the IP
receivers.

The communicator simulates a receiver by supplying
the handshake and kissoff messages.

GSM

SIA/Contact ID

Enabled

Disabled

Enabled

The digital messages (CID/SIA) are decoded and
forwarded on the cellular data network to the IP
receivers.

The communicator simulates a receiver by supplying
the handshake and kissoff messages.

The digital messages (CID or SIA) are converted to
voice or SMS messages (as set in the
Communicator > CID/SIA Converter page)

and forwarded on GSM3,

Table 12 - Effects of the CID/SIA Event Conversion, Virtual Receiver on GSM Path and |P Receiver on GSM
Path options on the communicator's operation.
1) Refers to the communications channel used by the communicator.
2) See the Options page.

3) Only if the panel's communications protocol is compatible with that of the communicator.

4) SIA and CID messages may NOT be understood by the receivers due to distortion on the GSM network.
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Options

I This page differs depending on the user's access level: normal user, installer, level 4 installer.

User Authentication
0 Installer Code Enabled: the normal user uses this option to enable the installer for programming the communicator.

IS The installer need only be enabled if the EN50136 option is enabled.
The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.

O User Code: enter the normal user code here (at most 6 digits), for use, among others, in remotely activating the outputs.
Factory setting: 000000.

Installer Authentication

O Installer Code: enter the installer code here (6 digits). Factory setting: 111111.

O Level 4 Installer Code Enabled: the installer can enable the level 4 installer code for communicator firmware updates
here.

IS This option is disabled if the EN50136 option is disabled.
0 ENS50136: the installer can enable/disable the EN50136 option in this box.

IS To ensure conformity with EN 50136-2, the EN50136 option should NOT be disabled.

Level 4 Installer Authentication
O Level 4 Installer Code: enter the level 4 installer code here (6 digits). This code gives access to firmware updates and
Satuspage display. Factory setting: 222222.

Dialing Options
This section configures certain aspects of the phone numbers.

O Dial Prefix: the number entered in this box is placed before any number dialled by the communicator in GSM Interface
mode. Enter the prefix (1 to 8 digits) or leave the field empty, if unused.

O Digits to Remove: if the communicator is connected to a phone switchboard, the phone numbers (programmed in the
panel) must be preceded by the switchboard number (normally a single digit). Since the switchboard number is not
necessary when calls are made to the GSM network, it must be removed from the number. Enter the number of digits that
form the switchboard number (e.g. if switchboard number is 01, enter 2 in the Digits to Remove option, as 2 numbers form
the switchboard number).

I The phone number must have at least two digits more than the number entered in Digits to Remove, otherwise the engaged
tone is generated.

Example:

1. Setthe Dial Prefix = 9999 and set Digits to Removeto 2 on the communicator.
2. Configure a voice call on the panel using the number 9999011234567890.

3. Activate the call on the panel.

4. The communicator will send the call to the number 1234567890.

I |f the Digits to Remove option is enabled and the panel calls a number which has CID/SI A Event Conversion enabled
(see Phonebook), the phone number in the phonebook must match the one programmed on the panel (including prefix), in
order for the communicator to convert it.

BGS-210/BGS-220 / B3G-220 41



O Black List Enabled: if enabled, the communicator forwards to devices connected to terminals L1, the calls coming from
telephone numbers with White List option is enabled ONLY (see “Phonebook” on page 39).

IS This option affect ONLY calls over GSM; incoming calls to communicator's terminals L E are ALWAYS forwarded to terminals
LI.

IS" The Black List function COMBINED with Activate Output on Caller ID delays call refusal by a few seconds. The
confirmation ring tone associated with Activate Output on Caller ID delays call refusal by a few seconds. If the call is refused
immediately, the output has not been activated.

O Tones: select the country of Communicator installation; the selected country will set adequately a series of parameters for
the proper working of the simulated telephone line.

O Roaming Enabled: enables GSM roaming.

Priorities

This options allows you to configure some priorities on the communicator relating to alarm event transmission.

O Dialer /LI Priority: defines the priority of the communicator (send voice messages, SMS and digital messages to central
station receivers) and the LI (events transmitted by devices hooked up to the L | terminals, such as a burglar alarm panel).

O Dialer Events Priority: sets the priority of the communicator (e.g. 1:Rx; 2:Ring; 3:Digital Calls; 4:Voice Calls;
5:SMS).

Generic
This section sets the loudness of the GSM communicator's speaker and microphone.

O Speaker Volume: set the communicator's speaker volume: change this setting if the panel connected to terminals LI of the
communicator is unable to decode the DTMF commands.

O Microphone Volume: set the communicator's microphone volume: change this setting if the user is unable to understand
the voice messages sent by the panel connected to terminals LI of the communicator or by the communicator itself.

IS A high microphone volume setting can corrupt the DTMF tones from devices connected to terminals LI, and make them
incomprehensible.

0 Enable Antenna Cut Detection: if enabled, the Antenna Fault event is tripped when the antenna is not present or in
short circuit.
O EnableBattery Detection: if enabled, the Battery Fault event is tripped when battery faults are detected.

Automatic Clock Adjust
The options of this section is for the automatic synchronisation of the communicator's clock.

O SIM Phone Number: enter the phone number of the SIM card in the communicator (up to 16 digits).

0 Auto SMS: if enabled, the communicator updates the system date and time by sending an SMS to the number specified in
the SIM Phone Number option. Factory setting: enabled.

O IP Clock Adjust: if enabled, the communicator gets the date and time from the IP receiver 1, when configured and
connected. Factory setting: enabled.

IS |n order to ensure compliance with EN 50136-2, the Auto SMSand | P Clock Adjust options must be enabled.

Pay As You Go Balance

IS At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.

This section configures the system so that an SMS containing the service provider's pay as you go balance information is periodi-
cally sent to the first number in the Phonebook. Program the following options for a proper pay as you go balance request, depend-
ing on the service provider in question.

I Check with the SIM card provider for the methods and any charges for the available credit request.
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Enquiry Type: select the type of request (none, SM 'S, Call, Service Command).

Enquiry Number: telephone number to call or to which an SMS message should be sent in order to request credit balance
information.

Balance M essage: string used in the SMS requesting the balance using network commands.

Enquiry Interval: enter the interval within which the periodic SMS is to be sent with the balance information (if handled by
the operator). The interval is composed of the following values:

— Days, day of next send—select to send the next periodic SMS. The value runs from 0 to 364;

— Hours, time of next send—select to send the next periodic SMS. The value runs from 0 to 23.

SIM Expiration

0 SIM Expiration Message: enables sending the SMS (user programmable) with the expiration data to the first number in
the phonebook.

O SIM Expiration Date: once the expiration date is set, the message is sent 30, 15, 7, 6, 5, 4, 3, 2 and 1 days prior to the
expiry date itself. Click on Now to set the PC's time.

oo OO

IS" The SMS is sent once every programmed day: if it fails, no further attempt is done.

Protocol Settings

0 Handshake Repetition: set the number of handshakes generated by the communicator and sent to the panel connected
to terminals L 1. Range: 1 to 4.

0 Communication protocol: select the protocol: Contact ID or SIA.

I Depending on this setting, the communicator will decode CID or SIA events from the panel connected to the LI line; the setting
must be the same for all numbers handled by the communicator.
The installer must check that the operator (Wind, Tim, Vodafone, etc.) works reliably with CID (Contact ID) on the GSM
network, due to issues with transmission quality.

Network Settings

This page is used for starting a session / programming remotely

Device | D: enter the Communicator's serial number you can find on the Communicator’s electronic board.

Remote Access: check this box to enable remote programming.

Remote Access APN: access point name, up to 32 characters. This is generally supplied by the cellular network operator.
Remote Access User Name: some operators require user authentication; enter the user name in this field.

Remote Access Passwor d: enter the password in this field.

ooooo

I See paragraph “Start a remote session” on page 34.
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I nputs/Outputs

This page is used for setting the input/output modes, the output activation events, their standby polarity (NC or NO), the reserved
outputs, and the remote activation SMS strings for the reserved outputs.

O Input/output: double click on the input/output number to view the settings.

O Labe: enter an alphanumeric string of at most 16 characters.

O 1/0 Type in this column you can program terminals T1, T2, T3, T4, T5 and T6 for the following modes:

— Input, select this mode to configure the terminal as an input line;
— Output, select this mode to configure the terminal as an open-collector output;

O Polarity: this option is used to program the output/input standby status:

— Normally Closed: the terminal is grounded (negative) when the input/output is at standby;
— Normally Open: the terminal is floating when the input/output is at standby.

O Output: if set as output, double click on [+] to display the column relating to the event to program for the output. The check
mark indicates that the output in question will be activated when the event occurs. Click on the boxes to check/uncheck them.

I Programming events for an output implies that certain boxes relating to the output are disabled.

» Panel Interconnection Fault: if selected, the output is activated when the panel is not present.

» Jamming Detect: if selected, the output will be activated if the device is subject to radio disturbance.

» Antenna Fault: if selected, the output is activated if the antenna is not present or has limited function (only with ANT5-02).

» Tampers: if selected, the output will be activated when tampering is detected (opening the cover, removal from the wall).

» PSTN Fault: if selected, the output is activated if the external phone line fails (connected to the L E terminals).

» GSM Fault: if selected, the output is activated if GSM network coverage fails.

» No Cellular Network: if selected, the output is activated when problems occur with the cellular network connection.

» |P Receiver Fail: if selected, the output is activated whenever a problem occurs with the IP receiver.

» FTC Fault: if selected, the output is activated when a phone action does NOT terminate successfully and returns to
standby when the most recent phone action terminates successfully.

» Power Fault: if selected, the output is activated when a power problem is detected.

» Reserved Output: if selected the output may be activated by Caller ID or SMS.

IS If the Reserved Output option is enabled, all other options are disabled.

» Control Sring: in this option, enter the string (maximum 16 alphanumeric characters) to be sent by SMS when you wish to
activate/deactivate the corresponding output remotely. This function is available even if Caller ID is not enabled.

» Activation Confirmation: select the type of confirmation you want to receive when the output is activated: none, Ring,
SM S (NOT available when the Control String option is left blank) and Ring + SM S. If the output is activated by an SMS,
the activation confirmation will be sent by SMS (see table below).

SETTINGS EFFECTS
Black List White List Activation Call Forwarded Confirmation
Enabled Confirmation (only if the communicator is switched to GSM) Ring

Disabled Disabled None YES NO

Disabled Disabled Ring NO YES

Disabled Enabled None YES NO

Disabled Enabled Ring NO YES

Enabled Disabled None NO NO

Enabled Disabled Ring NO YES

Enabled Enabled None YES NO

Enabled Enabled Ring NO YES
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O Type normally the outputs, when activated, remain so until a deactivation command is received (Bistable), at which point
the output will revert to its standby status. If you wish the output to return to standby automatically after a set period of time,
select the option M onostable and set this time in the option M onostable Time ON next to it.

O Monostable Time ON: enter a value in seconds (1 to 86400 in 1 second steps) to indicate the time for which the output,
if monostable, remains active before returning to standby.

I nput

When a T1, T2, T3, T4, T5 or T6 terminal is configured as an input, it can be programmed as Normally Open or Normally
Closed (see Polarity). The input is polled at least every 30 ms and, if its state remains stable for more than 300 ms, Input 1
Event is generated (for terminal T1).

The following options are available when programming the inputs:

» Panel Interconnection Present: if enabled, deactivation of the input generates the Panel Interconnection Fault
event and activating the input generates the Panel I nterconnection Restoreevent.

» Dialer Block: if enabled, activating the input blocks the communicator and deletes the queue.

» Force Communication on Simulated Line: if enabled, activating the input switches from PSTN to GSM.
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Communicator

This page configures the events transmitted by the communicator.
Communicator Options

SM S/Voice Calls

Call Options

O Call All Numbers: select this option to call all numbers set for a given event.
You can select: Voice Calls, CID: Over GSM, Voice Callsand CID: Over GSM and Disabled. If this option is not
selected, the communicator terminates the cycle of calls as soon one of them terminates successfully.

O Call Confirmation: select this option to have the dialer wait for the remote user to confirm reception of the voice message,
otherwise the dialer will try sending the voice message again; the remote user can confirm by pressing J on his phone
(for tone dialling phones only).

I While listing to a voice message, pressing Jonthe phone keypad blocks both the current call and any queued calls as well.
In some cases the dialer may interpret the response of answerphones, GSM operator courtesy messages and so on, S0 we
recommend leaving Call Confirmation enabled.

0 Repeat Call: this option is used to enter the number of attempts to be performed (up to a maximum of 8) if the call is not
successful.

O Repetitions: enter the number of times the voice message is to be repeated (up to 8) when the called number answers.

0 Voice message Header: select the voice message the communicator will play at the begin of each voice call.

Periodic SM S and Voice

O Periodic SMS/Call Send Interval: set the interval (Days and Hours) between two Periodic Call/SM S events.
Range: 0 to 365 days and 0 to 23 hours.

O Periodic SMS/Call First Send: select the date and time for sending the first Periodic Call/SM S event.
The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.
The Now button sets the PC's current time.

I |n order to ensure conformity with EN 50136-2, the Periodic SMS/Call First Send time must be set to 1 day, and this
function may not be modified. Factory setting: 1 day.
To set the options for Periodic SMS/Call First Send, enter the SIM Phone Number and enable Automatic Clock
Adjust options in the Options page.

O Ring only for periodic event: with this option enabled, the system sends a 5 s ring tone instead of a periodic voice
message.

Periodic Call

O Periodic Test Transmission Interval: set the interval (Daysand Hour s) between two Periodic Test Transmissions
events. Range: 0 to 365 days and 0 to 23 hours.

O Periodic Test Transmission First Send: set the date and time of the first Periodic Test Transmission event.
The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.
The Now button sets the PC's current time.

SIA
0 Date/Timeon SIA packet: if enabled, the SIA packet will include the date and time.
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Inputs and Events
sMS

This table specifies, for each event handled by the communicator, the SMS messages to send to the numbers specified in the
column SMS Tel. Number.

0 Event: this column lists the events for which a SMS message is to be sent.

I |nput 1 Event (or 2, 3, 4, 5, 6) and Input 1 Restore (or 2, 3, 4, 5, 6) only occurs if terminal T1 (or T2, T3, T4, T5, T6) is
configured as an input (see | nputs/Outputs).

O SMSTel. Numbers: select the numbers to which an SMS is to be sent.
Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

0O SMSText: enter the text to be sent when the event occurs (up to 70 characters).

Voice Calls

This table specifies, for each event handled by the communicator, the voice messages to send to the numbers specified in the col-
umn Telephone Numbers.

O Telephone Numbers: select the numbers to which the event is to send a voice message.

Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

0 Voice Messages. select the voice messages to be sent in response to the event: you can select up to three voice messages
per event (First M essage, Second M essage and Third M essage); click on [...] to browse the list of messages; you can
select a pre-recorded message (see Voice M essages) or record a new one, or open a .wav file on the PC. The Header
column shows the message selected in Call Options> Voice M essage Header.

Central Sation Calls

This table specifies, for each event handled by the communicator, the digital messages to send to the numbers specified in the
column Telephone Numbers.

O Event: this column lists the events for which a digital message is to be sent.

O Telephone Numbers: select the numbers to which the event is to send the digital message, when you have selected
Channel Type, CID: Over GSM.
Double click on [+] to expand the column: a table will be shown to specifies which numbers in the Phonebook are to be
used for sending digital messages (up to 8 numbers can be set).
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

I When you select Channel Type, CID/SIA: over Data Network, the events are transmitted to the IP receivers indicated
in the | P Receivers page.
O Customer code: enter the user code (4 hex characters).

I You can set a different Customer code for each Input Event, or a single Customer code for all other events.
DO NOT use the character “A” for Contact ID.
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Contact ID Identifier: enter the Contact ID the communicator is to send for the event.

The communicator also sends the qualifier 1 when the event occurs and the qualifier 3 when it terminates, as required by the
Contact ID protocol.

The communicator also sends the number of input that has triggered the event (the zone number): 01 for input 1, 02 for input
2, 03 for input 3, 04 for input 4, 05 for input 5, 06 for input 6.

Event SIA Identifier: enter the SIA code the communicator is to send when the event OCCURS.

Restore SIA Identifier: enter the SIA code the communicator is to send when the event TERMINATES.

Event Enabled: select Disabled to NOT send the event; select Send Activation to send ONLY the event's occurrence;
select Send Restoral to send ONLY the event's restoral; select Send Activation and Restoral to send both.

Channel Type: select CID: Over GSM to send the event with the Contact ID protocol using a voice call on GSM; select
CID/SIA: over Datato send the event with the Contact ID or SIA protocol on the cellular network (the protocol will be the
one selected in the Communication Protocol option in the Options page).

CID/SIA Converter

If the communicator detects that the panel connected to the L | terminals is dialing a number from the Phonebook with the option
CID/SIA Event Conversion enabled, it converts the panel's Contact ID or SIA message into a voice or SMS message,
as indicated in this page.

The following tables show the way the CI D/SI A Converter subgroup options concur in building of SMS and voice message.

Labels/
1 M essages SMS L abels/M essages (5)
Activation or Users>
SMSHeader | Advanced > Activation or | SMSHeader | Partitions SMS Header for L abel or
2 user or SMS
for event Restoreor for area > Label Header for zone Zones>
Advanced > Restore Label
3|7 16 7 16 7 16
Bentel Alarm Partition Warehouse |Zone Entrance
. Bentel Alarm end Partition Warehouse |Zone Entrance
Bentel Arming Partition Warehouse |User Brown
Bentel Disarming Partition Warehouse |User Brown

Table 13 - Conversion of Contact ID and SIA message to SMS: 1) option subgroup; 2) option; 3) SMS maximum length;

4) examples; 5) Contact ID only.
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Communicator

1 Options Voice Calls L abels/M essages (5)
Activation or
5 VoiceMessage | Advanced > Activation or Partitions > Voice M essage Users> Voice M essage or

Header Restoreor
Advanced > Restore

Zones> Voice M essage

3 |6 seconds 6 seconds 6 seconds 6 seconds
Bentel Alarm Warehouse Partition Entrance Zone

. Bentel Alarm end Warehouse Partition Entrance Zone
Bentel Arming Warehouse Partition Brown User
Bentel Disarming Warehouse Partition Brown User

Table 14 - Conversion of Contact ID and SIA message to voice message: 1) option subgroup; 2) option; 3) voice message
maximum length; 4) examples; 5) Contact ID only.

Two setup modes are possible:

» the base setup allows you to convert digital messages to voice and/or SMS messages by setting up a small number of
options: messages will signal event activation and restore only.

» the advanced setup allows you to convert digital message details like event description and, for Contact ID protocol, the
involved partition, zone and user.

SM S/ Voice Calls

Base setup allows you to define general messages for Alarms, Tampers, Openings and Closings and System Troubles
event categories, as explained in the following paragraphs.

O Category: shows the event categories. Settings made for a category will be automatically copied into all the category
events, in the Advanced group.

I |f different settings for each event are required, the following options must be empty and the required settings shall be made
in the Advanced group.

0 Telephone Numbers: select the numbers to which the event is to send a message.
Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

Header: shows voice message selected in Communicator Options> Voice M essage Header. The communicator will play
this message at the begin of each voice call. It is generally used to identify the system.
IS This option is available in Voice Calls group only.

O Activation: setup the message the communicator sends when an event in that category occurs.
O Restore: setup the message the communicator sends when an event in that category ends.
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Advanced

This option group allows for the setup of different option for each event, over those explained in the base setup, as explained in the
following paragraphs.

a

a
(IS
1=y

oo

&

Event: shows the events the communicator can convert.
Contact ID Identifier: shows the default Contact ID code for the event. This option can not be modified.

This option is considered only if Contact | D has been selected as Communication Protocol in the Options page.

If Contact ID codes differ from defaults have to be converted, you can set up to 10 custom event codes for events in the
Custom group you can find at the end of event group list.

Event SIA Identifier: enter the SIA event code to be converted for the event verification.
Restore SIA Identifier: enter the SIA event code to be converted for the event restore.

The Event SIA Identifier and Restore SIA Identifier options have default values that have to be verified. Enter 00 if
conversion is not required.

The Event SIA Identifier and Restore SIA Identifier option is considered only if SIA has been selected as
Communication Protocol in the Options page.

L abels/M essages

The Contact ID protocol sends information on users, zones and partitions of the events.

Options in this group allow for assignment to each user, zone and partition number a SMS and/or voice message used for the mes-
sage building during the conversion.

=

(IS

a

Up to 128 user / zone / partition numbers in total can be converted.

SIA protocol also sends information on users, zones and partitions but they are NOT converted by this communicator. If SIA
is selected as Communication Protocol in the Options group, you can setup the SMS Header for event option ONLY.

SM S Header for event: enter the text you want at the begin of each SMS. Generally it is used to identify the system.
Valid entries: up to 7 characters.

Default: empty.

SMSHeader for user: enter the text you want before the message set for user identification.
Valid entries: up to 7 characters.

Default: a comma.

SM S Header for zone: enter the text you want before the message set for zone identification.
Valid entries: up to 7 characters.

Default: a comma.

SMSHeader for area: enter the text you want before the message set for partition identification.
Valid entries: up to 7 characters.

Default: a comma.
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Users/ Zones/ Partitions

a

oo

Send only if user is defined / Send only if zoneis defined / Send only if area is defined: if disabled (default), a
digital message is converted even if its user / zone / partition number is NOT present into the conversion tables. In this case
the user / zone / partition information will be not present. If enabled, digital messages without user / zone / partition
information in the conversion tables will be NOT converted.

Add: select this button to add a user / zone / partition number to convert.

User Number / Zone Number / Partition Number: enter the number to convert.

Valid entries: from 0 to 999; 65535 to disable.

Default: 65535.

L abel: enter a text useful for user / zone / partition identification.

Valid entries: up to 16 characters.

Default: empty.

Voice M essage: select a voice message useful for user / zone / partition identification.

Default: (none).

Iﬂ’: select this button to delete relative row.
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| P Receivers

This page sets the options relating to the communicator's connection with Sur-Gard System IP receivers I, I1, 111, 1V and 5.

=

=

Given possible delays in transmission on the cellular data network, depending on the activity of the network operator,
we recommend programming as high as possible the number of call attempts on the panel, and also setting a backup phone
number which will send the alarms via GSM rather than cellular data network.

The communicator does NOT support the shuntdown command by Sur-Gard receivers.

Receiver Options

a

0 0O O §

Fibro Account #: enter the account number for the Fibro protocol: when transmitting events to IP receivers, the Contact ID
and SIA are wrapped in the Fibro protocol and this requires its own account number to identify the account which is sending
the events.

Contact your central station for details. Factory setting: 0000FFFFFF.

You must assign a different account number to each communicator which transmits events to a given receiver.

DNI'S: the communicator transmits the DNIS code inside the Fibro packet to enable the receiver to identify the device (hex
numbers from 00000 to FFFFF).

Encryption Enabled: if enabled the communicator encrypts all communications with the IP receivers to increase the
security of its data transmissions.

Hold ACK in memory timeout: sets how long an IP receiver ACK (acknowledge) is kept in memory. Within this period of
time, if the communicator detects that the panel is attempting again to send a message to the IP receiver and the latter
acknowledges it (ACK), the communicator confirms reception directly to the panel with a kiss-off signal, without sending the
message again to the IP receiver. If set to 0 (factory setting) ACK's are not held in memory. It is worth setting a value greater
than 0 when the panel attempts to transmit each call only once and does not manage to receive the ACK from the IP receiver
on time. Range: 0 to 15 minutes. Factory setting: 0.

Receiver 1

§ 0O 0D 0O O

B 0O B OOO

Receiver functionality mode: select Primary (receiver 1 is enabled) or Not Used (receiver 1 is disabled, the
programming of receiver 2 will be ignored, CID/SIA event transmission is disabled).

Cellular Receiver 1 Address: enter the receiver's IP address. The address can be entered in the numeric format

(.. 192.168.0.101) or host and domain format (Fully Qualified Domain Name, e.g., host_name.domain_name.com).
Receiver 1 Remote Port: enter the UDP port receiver 1 is listening to. Range: 1 to 65535. Factory setting: 3061.
Receiver 1 Local Port: for each receiver, the communicator uses a different UDP port. Range: 0 to 65535. If the local port is
0, the communicator uses a random port number in the range 1-65535. Factory setting: 3060 (3065 for receiver 2).

APN 1: enter the Access Point name. This is generally supplied by the cellular network operator.

Make sure the APN is correct for access to the cellular data network, otherwise certain functions may be limited (contact your
phone operator for details).

APN1 User Name: some operators require communication authentication; enter the user name in this field if necessary.
APN1 Passwor d: some operators require communication authentication; enter the password in this field if necessary.
Supervision 1 Enabled: if enabled, the communicator supervises communications with the receiver.

The supervision messages are not sent during voice calls (on GSM).

Supervision Time 1: set the supervision time. Range: 60 to 65535 s, in 1 s steps.

In order to ensure conformity with EN 50136-2 supervision must be enabled and the Supervision Time must be no more than
3 minutes.
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Receiver 2

The options for Receiver 2 are the same as those for Receiver 1, except for the differences described below.

=
a
>
>

>

If Receiver functionality modefor receiver 1 is Not Used, you can NOT set the options for receiver 2: transmission of CID/
SIA events to the central station is disabled.

Receiver functionality mode: if Receiver functionality mode for receiver 1 is Primary, receiver 2 may be:

Not Used, receiver 2 is disabled, the communicator sends the CID/SIA to receiver 1 only (this mode is called “single mode”);
Backup, the communicator sends the CID/SIA messages to receiver 1 and, should it not be operational or reachable, sends
them to receiver 2 (this mode is called “Main + Backup”);

Redundant, the communicator sends the CID/SIA to both receiver 1 and receiver 2 simultaneously and sends the ACK
(confirmation of reception) to the panel only if both receivers confirm reception (this mode is called “Redundant”).

Voice M essages

This page enables you to record and play back voice messages: refer to “SMS/Voice Calls’ on page 46, for how to associate
messages to events.

The voice messages can be recorded with a microphone connected to the PC, you can load pre-recorded messages from the PC
(hard disk, LAN, USB key, etc.) or you can import voice messages from another communicator, as described in paragraph
“Programming/Audio Import/Export” on page 38".

ISy

]

The Console can import all type of audio files in the WAVE format (.WAV).

Play button: press this button to play back a voice message.

Record button: press this button to start recording a new voice message.

Stop button: press this button to stop playing back or recording the current voice message.
Pause button: press this button to pause playing back or recording the current voice message.

Clear button: press this button to delete a voice message saved in the communicator.

=
" Open button: press this button to load a voice message from a PC resource (hard disk, LAN, etc.).

Save button: press this button to save a voice message to a PC resource (hard disk, LAN, etc.).

I While a message is being recorded, a progress bar indicates the duration so far.
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PSTN/PTM

This page relates to the PSTN line and the PTM function (Panel Transmission Monitoring). The PTM function enables the
communicator to forward calls on the GSM channel if communications between the panel and the receiver on the PSTN line fail.

I After 5 minutes of use of the GSM line, the communicator will start using the PSTN line again for forwarding panel calls.
The PTM function considers communication to have failed when:

» itdoes not detect dialing, if the Check Dialing option is enabled (it checks that a number is actually dialled);
» it does not detect the kiss-off (the signal sent from the receiver when a communication terminates successfully).

If the PTM All Number s option is enabled, PTM is executed when the panel dials any number, otherwise it only monitors the
dialling of numbers which have the PTM option enabled in the Phonebook.

Calls are forwarded on the GSM channel when the PTM Max ErrorsBefore Takeover setting is reached.

Primary Path

O Primary Communication Path: if you set PSTN, the communicator uses the PSTN line as its primary channel and
switches to GSM only when the PSTN fails or when the PTM function trips; if you select GSM, the communicator uses
ONLY GSM.

Timeouts
0 LE Failure Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the L E terminals can be absent
before the PSTN Fault event occurs.

I |f any phone devices are connected to the L1 terminals, this time may increase up to a maximum of approx. 60 s.
O LE Restore Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the L E terminals must be

present before the PSTN Fault Restor e event occurs.

IS To ensure conformity with EN 50136-2, the LE Restore Timeout (sec) option should not be modified. Factory setting: 10 s.
PTM

O PTM Max ErrorsBefore Takeover: the communicator switches to GSM when it detects this number of failed attempts.
Range: 1 to 4, 0 disables the option. Factory setting: 0 (disabled).

0 PTM All Numbers: if enabled, PTM is executed when the panel dials any number, otherwise it only monitors the dialling
of numbers which have the PTM option enabled in the Phonebook.

I The PTM Max Errors Before Takeover option must be non-zero before you can modify the PTM All Numbers setting.

O

Check Dialing: if enabled, the communicator considers a off-hook followed by a on-hook without any number being dialled
by the device connected to the L | terminals to be a failure. Factory setting: disabled.

IS" The PTM Max Errors Before Takeover option must be non-zero before you can modify the Check Dialing option.

Generic

0 Dialing Prefix: when the communicator detects a number being dialled with the prefix in this setting, it sends the call to the
GSM channel, to the phone number without the digits indicated in this option, even if the PSTN in available. Factory setting:
9999.
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Event Log

The Event L og page displays the events logged by the communicator.
The communicator can save up to 2048 events: when the buffer is full, each new event overwrites the oldest, which is thus lost.
Each event indicates the date and time at which it occurred.
Svmbols on the Event Buffer bar
U Click on this icon to load the new events the next time a Global Upload or Communicate Tagsis run.
= Click on this icon to cancel the selection of events in the event buffer.

i Click on this icon to open a window for saving an .XML file of the events loaded in the Event L og page.

I The XML file can be viewed with Excel or a compatible application.
el
¥ Click on this icon to display the events in relation to the criteria indicated in the Events In and With Text options.

O Events|In: select the events you wish to view: All Events, Today, Last 7 Days, Last 14 Days, Last 30 Days, Last
Year or Custom.
Select Custom to set a specific period of time.

O With Text: only events containing the specified text will display.

Firmware Update

A\ Firmware updating from 1.00 and 1.10 revisions to 1.20 revision and above causes loss of settings relative to CID/SIA
conversion.

IS Only the level 4 installer, when enabled by the installer, can run firmware updates.

The Firmware Update page updates the communicator's firmware, both locally (PC-Link or USB) and remotely (cellular data
network).

Click on Select Firmware Fileto select the update file.

If the firmware update does not terminate successfully, the communicator will continue using the old version.

The name of the firmware file has the format FWxxyyzz.bin where:
» FW identifies the file as firmware;
»  xx is the higher revision number;
» yyis the lower revision number;
»  zzis the test revision number;

.bin is the extension for a binary file.
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Satus

This page gives a range of information about the communicator, as indicated below.

When you select the Status page, the Console automatically displays the Communicate Tags window to establish
communications with the communicator; once it is, the Status page updates every 5 seconds

Device I nformation

The Device Detailsbox shows information which may be requested by technical assistance.

The Network Status box shows information relating to the GSM network, as given below.

g OO OODOO

Options page have been set properly.

GSM Provider Name: indicates the name of the mobile phone operator.
GSM Signal Strength: gives the strength of the GSM signal.
Ceéllular: the type of network.

Best Operator: when no SIM is in the communicator, it shows the mobile operator with the best signal strength.

Last Credit Received: shows the SIM's credit updated to the last request made with the Request for PayAsYouGo
Balance button or as programmed in the Pay As You Go Balance section of Options page.

Last Credit Date/Time: shows the date and time of the last credit update.

Request for PayAsYouGo Balance: press this button to display the residual credit of the communicator's SIM card.

This function is only available with the local connection (PC-LINK or USB) and if the Pay As You Go Balance options in the

GSM
LED Normal operation Malfunction
GSM ready Green: the GSM network is available and the|Red: the communicator is not yet ready.
communicator is operating.
Radio ON Green: the radio module is on. Red: the radio module is off.
SIM OK Green: the SIM is properly functioning. Red: there is a problem with the SIM card: SIM not
present, SIM expired, PIN enabled on SIM.
Carrier OK Green: the operator is connected. Red: the operator has not been connected.
Signal OK Green: the signal strength is above the required | Red: signal too low or no signal.
minimum.
Main board
LED Normal operation Malfunction
Power OK Green: main power (+V terminal) is above the|Red: main power (+V terminal) is less than 10 V.
minimum threshold.
Battery OK Green: the communicator's battery (if any) is|Red: the battery voltage is less than 3.4 V.
charged.
PSTN OK Green: the PSTN line (connected to the|Red: the voltage on the LE terminals is less than
communicator's L E terminals) is available. 25V.
No Jamming Green: no jamming. Red: the communicator's function is being jammed
(sabotage).
Antenna OK Green: the antenna ANT5-02 is connected and |Red: the antenna ANT5-02 is connected but NOT
working properly. working OK (wire cut).
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Incoming Call: orange—the communicator is receiving a call.
Call In Progress. green—the communicator is engaged with a call.
Outgoing Call: orange—the communicator is making a call.
Radio Initializing: green—the radio is initialising.

Passthrough: not supported.

eceiver 1

Status:

grey: the options for receiver 1 have NOT been programmed;

orange: receiver 1 is connected but NOT initialised;

red: the options for receiver 1 have been programmed but the receiver is not initialised, has disconnected due to a problem,
is unable to connect or initialisation has failed;

green: receiver 1 is initialised and connected.

Cellular Connection: green—the communicator is transmitting messages to receiver 1.

Receiver 2

a
a

Status: as for Receiver 1 but for receiver 2.
Cellular Connection: green—the communicator is transmitting messages to receiver 2.

Inputs

Shows input status: grey, standby input; green, active input.

Outputs

Shows output status: grey, standby output; green, active output.

BGS-210/BGS-220 / B3G-220 57



APPENDIX

Conformity with EN 50136-2:2013

To be compliant with EN50136-2:2013, the communicator must be configured and connected to a burglary alarm panel in one of
the two following ways (A and B) only:

A) PSTN connection (the panel must monitor the receiver's response directly via PSTN)

PSTN: The communicator's L | terminals are connected to the panel's external phone line terminals.

Terminal T4, configured as the Tamper output, is connected to the panel input (models with plastic housing only).

Terminal T5, configured as the GSM Fault output, is connected to the panel input.

Terminal T3 configured as Interconnection Present, is connected to the panel signal, to report that the panel is present,
or phone line present signal.

» Terminal T6, configured as IP Receiver Communications Failure, is connected to the panel's Jamming input.

YV V VYV

IS |n the communicator's programming page | P Receivers—specify an IP receiver.

B) no PSTN

Terminal T4, configured as the Tamper + Jamming output, is connected to the panel input (models with plastic housing only).
Terminal T5, configured as the GSM Fault output, is connected to the panel input.
Terminal T 1, configured as the Alarm/Tamper input, is connected to the panel's intrusion alarm/tamper output.

YV V V

Input 1 Event is used to send the intrusion alarm code.

v R

Terminal T2, configured as an input, is connected to the panel's fault output.

Input 2 Event is used to send the fault code.

Terminal T6, configured as IP Receiver Communications Failure, is connected to the panel's input.

Terminal T 3 configured as Interconnection Present, is connected to the panel signal, to report that the panel is present.

The communicator's earth terminal must be connected to a panel input, to detect the connection between the panel and the
communicator.

Y V V @

I |n the communicator page Central Station Calls, for the two events I nput 1 Event and | nput 2 Event, set a Customer
Code and set Channel Typeto CID/SIA: over Data Network. In the | P Receivers page, specify an IP receiver.
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See the following tables.

Communicator Panel
m € =
T1: PSTN Fault output
T2: No Cellular Network output
| T3: Interconnection Present €« LE Detection output
o
é T4: Tamper output - Communicator Tamper input
5‘ T5: GSM Fault output > GSM Fault input
Q
& [T6: IP Receiver Communications Failure output -> IP Receiver Communications Failure input
Table 15 — Connection scheme A: simulated PSTN.
Communicator Panel
T1: Alarm/Tamper input < Alarm/Tamper output
T2: Fault input €« Fault output
2|T3: Interconnection Present €« Interconnection Present input
&; T4: Tamper + Jamming output -> Communicator Tamper input
S -
L‘% T5: GSM Fault output -> GSM Fault input
T6: IP Receiver Communications Failure output - IP Receiver Communications Failure input
Earth terminal -> Earth terminal

Table 16 — Connection scheme B: without simulated PSTN.

I The following must be configured: an event for sending the Alarm/Tamper Contact ID, in case of activation of input 1, and an
event for sending the Fault Contact ID in case of activation of input 2.
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Operations with the USB key

I The USB can ONLY be used if the communicator is in USB Host mode (see “Description of jumpers” on page 8) and the

ENS50136 option is disabled (see “Options’ on page 41).

The USB key allows you to:

»  update the communicator's firmware;

»  export/import the communicator's settings;

»  export/import the communicator's voice messages;
> export the communicator's event buffer.

When a USB key is inserted into the communicator's USB port, the following folders are created (marked with the symbol /).

— /BFW

|—| g FWxxyyzz.bin |

— 7 B_PROG 2 exporttit |

B import.txt

7 S8SSSSSS

— 7~ B_AUDIO D exporttit |

import.txt

7 SSSSSSSS

eprog001.bin

7~ EXPORT {—— 7 eprog002.bin |

eprognnn.bin

eprog001.bin

7 IMPORT |-

1

eprog002.bin

eprognnn.bin

eaud001.bin

-

7~ EXPORT [ ©

my
@
o5}
c
[N
(=3
=1
NS
o
=1

eaudnnn.bin

eaud001.bin

7 IMPORT | ) eaud002.bin

eaudnnn.bin

— 7/B_LOG log.txt

g elog001.csv |

7 S8SSSS8S

elog002.csv |

Figure 8 — File structure of a USB key used with the communicator.

g elognnn.csv
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SSSSSSSS represents the communicator's serial number (8 hex digits), so that a single USB key can hold data for several different
communicators: each communicator will read/write to its own folder.

When a USB key is inserted into the communicator, the following procedure is executed:

Firmware update, if a valid frmware is in folder B_FW;

Communicator settings file export, if the file export.txt is in folder B_PROG;
Communicator settings file import, if the file import.txt is in folder B_PROG;
Communicator voice message export, if the file export.txt is in folder B_AUDIO;
Communicator voice message import, if the file import.txt is in folder B_AUDIO;
Communicator event buffer export, if the file log.txt is in folder B_LOG;

Firmware Update

I e o

This operation updates the communicator's firmware from a USB key.
1. Download the firmware from the site www.bentelsecurity.com.

The name of the firmware file has the format FWxxyyzz.bin where:
» FW identifies the file as firmware;

»  xx is the higher revision number;

» yyis the lower revision number;

»  zzis the test revision number;

» .bin s the extension for a binary file.

I DO NOT rename the firmware file, otherwise the communicator will not recognise it.

2. Copy the firmware into folder B_FW on the USB key.
3. Insert the key into the communicator's USB port.

If the communicator finds an invalid firmware in folder B_FW, the ACT LED will flash slowly and the event Firmware Upgrade
failed - System is logged to the event buffer.

If the communicator finds a valid firmware in folder B_FW, which is also different from its current firmware, it will install it.

I |f more than one firmware file is in folder B_FW, the communicator will install the one with the highest revision number.
If folder B_FW contains a firmware which is less recent than the current one installed on the Communicator, it is installed
anyway: firmware updates allow you to install a more recent firmware or restore an older one than currently installed on the
communicator.

At the end of the process the communicator reboots and logs the event FW upgrade done - System.
in the event buffer.

Exporting settings
This operation exports the communicator's settings to a USB key.

1. Create the folder B_PROG on the USB key, if it is not already there.
2. Create a new text file in folder B_PROG and call it export.txt.
3. Insert the USB key into the communicator's USB port.

The communicator will export its settings to B_PROG\SSSSSSSS\EXPORT\eprognnn.bin, where:
» SSSSSSSS is the communicator's serial number;

» eprog is the prefix for a communicator settings file;

» nnnis an index from 001 to 999;

» .bin s the extension for a binary file.

The communicator will search the EXPORT folder for the settings file with the highest index and create a settings file with that index
incremented
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If the EXPORT folder already has a settings file with index 999, exporting is not possible: the ACT LED will flash slowly and the
event USB Programming Export Failed - System is logged to the event buffer.

Importing settings
This procedure imports settings from a USB key.

1. Create the folder B_PROG on the USB key, if it is not already there.

2. Create a new text file in folder B_PROG and call it import.txt.

3. Create the folder SSSSSSSS in B_PROG, where SSSSSSSS is the serial number of the communicator to which you wish to
import the settings.

4. Create the folder IMPORT in the SSSSSSSS folder.

5. Copy the settings file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the
Console.

6. Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will delete the file import.txt and will be programmed as specified in the imported settings file: it will then reboot
IS You can import settings files ONLY if the originating communicator has the same installer code.

IS If folder B_PROG contains both the files export.txt and import.txt, the communicator will first export its current settings
(backup) and then import the new ones.

Exporting Voice Messages
This operation exports the communicator's voice messages to a USB key.

1. Create the folder B_AUDIO on the USB key, if it is not already there.
2. Create a new text file in B_AUDIO and call it export.txt.
3. Insert the key into the communicator's USB port.

The communicator will export its voice messages to B_AUDIO\SSSSSSSS\EXPORT\eaudnnn.bin, where:
» SSSSSSSS is the communicator's serial number;

» eaud identifies the file as containing voice messages;

» nnnis an index from 001 to 999;

» .bin s the extension for a binary file.

The communicator will search EXPORT for the voice messages file with the highest index and create a new one with that index
incremented by one; if EXPORT already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly
and the event USB Audio Export Failed - System will be logged to the event buffer.

Importing Voice Messages
This procedure imports voice messages from a USB key.

1. Create the folder B_AUDIO on the USB key, if it is not already there.

2. Create a new text file in B_AUDIO and call it import.txt.

3. Create the folder SSSSSSSS in B_AUDIO, where SSSSSSSS is the serial number of the communicator to which you wish to
import the messages.

4. Create the folder IMPORT in the SSSSSSSS folder.

5. Copy the audio file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the
Console.

6. Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will import the voice messages.

IS If folder B_AUDIO contains both the files export.txt and import.txt, the communicator will first export its current audio
(backup) and then import the new messages.
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Exporting the Event Buffer

This operation exports the communicator's event buffer to a CSV format text file (Comma Separated Value) on the USB key: the
CVS file can be viewed with Excel and Noteblock.

1. Create the folder B_LOG on the USB key, if it is not already there.
2. Create a new text file in B_LOG and call it log.txt.
3. Insert the key into the communicator's USB port.

The communicator will export its event log to B_LOG\SSSSSSSS\EXPORT\elognnn.csv, where:
» SSSSSSSS is the communicator's serial number;

» elog identifies the file as an event buffer;

» nnnis an index from 001 to 999;

» .csvis the file extension.

The communicator will search SSSSSSSS for the log file with the highest index and create a new one with that index incremented
by one; if SSSSSSSS already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly and the
event USB Log Export failed - System will be logged to the event buffer.
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7
/ Bistable Output Activation: #User Code*Control String=ON*
Monostable Output Activation: #User Code*Control String=ON*TonU*
Ton = Activation Time; U = S for seconds, M for minutes, H for hours
Output Deactivation: #User Code*Control String=OFF*
User Code Change: #CUC*User Code*New User Code*
Installer Enable: #ENI*User Code*
Installer Disable: #DSI*User Code*
Remote Programming Enable: #ERA*User Code*ON*
Remote Programming Disable: #ERA*User Code*OFF*

\

J BENTEL
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~
N

Control String

Calling Number

Deactivation*

#
1
2
3
4
5
6

*) Write “Text Message” for bistable outputs or the Activation Time for mon-

ostable outputs.

SIM Balance Check: #CCC*User Code*
SIM Expiration Check: #EDC*User Code*

SIM Expiration Change: #EDU*User Code*DD/MM/YYYY*
Serial Number Display: #RID*User Code*
~
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